Machine Automation Controller NX1P

Practices Guide
for NX1P Programming

NX1P2-[][1[[]
SYSMAC-SE20I][]

Wikl ol Loy
U

LZE£ énline

fafehz aronline. comAviki

S/SInau

always in control

OomRON

ﬁ

P122-E1-01


hp
lzonlineWiki2

hp
MoreOnwiki

https://lalehzaronline.com/wiki
https://lalehzaronline.com/wiki/index.php/%D8%B1%D8%AF%D9%87:NX1P

© OMRON, 2017

All rights reserved. No part of this publication may be reproduced, stored in a retrieval system, or
transmitted, in any form, or by any means, mechanical, electronic, photocopying, recording, or
otherwise, without the prior written permission of OMRON.

No patent liability is assumed with respect to the use of the information contained herein. Moreover,
because OMRON is constantly striving to improve its high-quality products, the information
contained in this guide is subject to change without notice. Every precaution has been taken in the
preparation of this guide. Nevertheless, OMRON assumes no responsibility for errors or omissions.
Neither is any liability assumed for damages resulting from the use of the information contained in
this publication.

Trademarks

« Sysmac and SYSMAC are trademarks or registered trademarks of OMRON Corporation in Japan and
other countries for OMRON factory automation products.

» Windows is either a registered trademark or trademark of Microsoft Corporation in the United States
and/or other countries.

o EtherCAT® is a registered trademark and patented technology, licensed by Beckhoff Automation
GmbH, Germany

o EtherNet/IP™ is a trademark of ODVA.

« Celeron, Intel, and Intel Core are the trademarks of Intel Corporation in the USA and other countries.

« Microsoft product screen shot(s) reprinted with permission from Microsoft Corporation.

Other company names and product names in this document are the trademarks or registered
trademarks of their respective companies.




Introduction

Thank you for purchasing an NX-series NX1P2 CPU Unit and the Sysmac Studio.

This NX1P Programming Practices Guide for Beginners (hereafter referred to as “this Guide”)
describes the differences in programming between the NX1P and traditional controllers and the
programming procedures using the Sysmac Studio that are required to use an NX1P2 CPU
Unit for the first time. You can perform the procedures that are presented in this Guide to
quickly gain a basic understanding of the NX1P2 CPU Units and the Sysmac Studio. This
Guide does not contain safety information and other details that are required for actual use.
Thoroughly read and understand the manuals for all of the devices that are used in this Guide
to ensure that the system is used safely. Review the entire contents of these materials,
including all safety precautions, precautions for safe use, and precautions for correct use.

For the startup and operating instructions for motion control, refer to the NJ/NX-series Startup
Guide for Motion Control (Cat. No. W514).

Intended Audience

This Guide is intended for the following personnel, who must also have knowledge of electrical
systems (an electrical engineer or the equivalent).

* Personnel in charge of introducing FA systems

* Personnel in charge of designing FA systems

* Personnel in charge of installing and maintaining FA systems

Applicable Products

This Guide covers the following products.
* NX1P2 CPU Units of NX-series Machine Automation Controllers
» Automation Software Sysmac Studio

Special Information

The icons that are used in this Guide are described below.

I-—l;i Precautions for Correct Use

Precautions on what to do and what not to do to ensure proper operation and
performance.

@ Additional Information

Additional information to read as required.
This information is provided to increase understanding or make operation easier.




Terms and Conditions Agreement

Warranty, Limitations of Liability

I Warranties

o Exclusive Warranty

Omron’s exclusive warranty is that the Products will be free from defects in materials and
workmanship for a period of twelve months from the date of sale by Omron (or such other
period expressed in writing by Omron). Omron disclaims all other warranties, express or implied.

o Limitations

OMRON MAKES NO WARRANTY OR REPRESENTATION, EXPRESS OR IMPLIED, ABOUT
NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE
OF THE PRODUCTS. BUYER ACKNOWLEDGES THAT IT ALONE HAS DETERMINED
THAT THE PRODUCTS WILL SUITABLY MEET THE REQUIREMENTS OF THEIR
INTENDED USE.

Omron further disclaims all warranties and responsibility of any type for claims or expenses
based on infringement by the Products or otherwise of any intellectual property right.

« Buyer Remedy

Omron’s sole obligation hereunder shall be, at Omron’s election, to (i) replace (in the form
originally shipped with Buyer responsible for labor charges for removal or replacement thereof)
the non-complying Product, (ii) repair the non-complying Product, or (iii) repay or credit Buyer
an amount equal to the purchase price of the non-complying Product; provided that in no event
shall Omron be responsible for warranty, repair, indemnity or any other claims or expenses
regarding the Products unless Omron’s analysis confirms that the Products were properly
handled, stored, installed and maintained and not subject to contamination, abuse, misuse or
inappropriate modification. Return of any Products by Buyer must be approved in writing by
Omron before shipment. Omron Companies shall not be liable for the suitability or unsuitability
or the results from the use of Products in combination with any electrical or electronic
components, circuits, system assemblies or any other materials or substances or environments.
Any advice, recommendations or information given orally or in writing, are not to be construed
as an amendment or addition to the above warranty.

See http://www.omron.com/global/ or contact your Omron representative for published
information.

I Limitation on Liability; Etc

OMRON COMPANIES SHALL NOT BE LIABLE FOR SPECIAL, INDIRECT, INCIDENTAL, OR
CONSEQUENTIAL DAMAGES, LOSS OF PROFITS OR PRODUCTION OR COMMERCIAL LOSS
IN ANY WAY CONNECTED WITH THE PRODUCTS, WHETHER SUCH CLAIM IS BASED IN
CONTRACT, WARRANTY, NEGLIGENCE OR STRICT LIABILITY.

Further, in no event shall liability of Omron Companies exceed the individual price of the
Product on which liability is asserted.




Application Considerations
I Suitability of Use

Omron Companies shall not be responsible for conformity with any standards, codes or regulations
which apply to the combination of the Product in the Buyer’s application or use of the Product. At
Buyer’s request, Omron will provide applicable third party certification documents identifying ratings
and limitations of use which apply to the Product. This information by itself is not sufficient for a
complete determination of the suitability of the Product in combination with the end product,
machine, system, or other application or use. Buyer shall be solely responsible for determining
appropriateness of the particular Product with respect to Buyer’s application, product or system.
Buyer shall take application responsibility in all cases.

NEVER USE THE PRODUCT FOR AN APPLICATION INVOLVING SERIOUS RISK TO LIFE OR
PROPERTY WITHOUT ENSURING THAT THE SYSTEM AS A WHOLE HAS BEEN DESIGNED
TO ADDRESS THE RISKS, AND THAT THE OMRON PRODUCT(S) IS PROPERLY RATED AND
INSTALLED FOR THE INTENDED USE WITHIN THE OVERALL EQUIPMENT OR SYSTEM.

I Programmable Products

Omron Companies shall not be responsible for the user’s programming of a programmable
Product, or any consequence thereof.

Disclaimers

I Performance Data

Data presented in Omron Company websites, catalogs and other materials is provided as a
guide for the user in determining suitability and does not constitute a warranty. It may represent
the result of Omron’s test conditions, and the user must correlate it to actual application
requirements. Actual performance is subject to the Omron’s Warranty and Limitations of
Liability.

I Change in Specifications

Product specifications and accessories may be changed at any time based on improvements
and other reasons. It is our practice to change part numbers when published ratings or features
are changed, or when significant construction changes are made. However, some
specifications of the Product may be changed without any notice. When in doubt, special part
numbers may be assigned to fix or establish key specifications for your application. Please
consult with your Omron’s representative at any time to confirm actual specifications of
purchased Product.



I Errors and Omissions

Information presented by Omron Companies has been checked and is believed to be accurate;

however, no responsibility is assumed for clerical, typographical or proofreading errors or
omissions.

I Automation Software Sysmac Studio

e WARRANTY

« The warranty period for the Software is one year from the date of purchase, unless
otherwise specifically agreed.

« If the User discovers defect of the Software (substantial non-conformity with the manual),
and return it to OMRON within the above warranty period, OMRON will replace the Software
without charge by offering media or download from OMRON’s website. And if the User
discovers defect of media which is attributable to OMRON and return it to OMRON within
the above warranty period, OMRON will replace defective media without charge. If OMRON
is unable to replace defective media or correct the Software, the liability of OMRON and the

User’s remedy shall be limited to the refund of the license fee paid to OMRON for the
Software.

¢ LIMITATION OF LIABILITY

o« THE ABOVE WARRANTY SHALL CONSTITUTE THE USER’S SOLE AND EXCLUSIVE
REMEDIES AGAINST OMRON AND THERE ARE NO OTHER WARRANTIES,
EXPRESSED OR IMPLIED, INCLUDING BUT NOT LIMITED TO, WARRANTY OF
MERCHANTABILITY OR FITNESS FOR PARTICULAR PURPOSE. IN NO EVENT,
OMRON WILL BE LIABLE FOR ANY LOST PROFITS OR OTHER INDIRECT,
INCIDENTAL, SPECIAL OR CONSEQUENTIAL DAMAGES

« ARISING OUT OF USE OF THE SOFTWARE. OMRON SHALL HAVE NO LIABILITY FOR
DEFECT OF THE SOFTWARE BASED ON MODIFICATION OR ALTERNATION TO THE
SOFTWARE BY THE USER OR ANY THIRD PARTY.

e OMRON SHALL HAVE NO LIABILITY FOR SOFTWARE DEVELOPED BY THE USER OR
ANY THIRD PARTY BASED ON THE SOFTWARE OR ANY CONSEQUENCE THEREOF.

e APPLICABLE CONDITIONS

USER SHALL NOT USE THE SOFTWARE FOR THE PURPOSE THAT IS NOT PROVIDED
IN THE ATTACHED USER MANUAL.

¢ CHANGE IN SPECIFICATION
The software specifications and accessories may be changed at any time based on
improvements and other reasons.

¢ ERRORS AND OMISSIONS
The information in this manual has been carefully checked and is believed to be accurate;

however, no responsibility is assumed for clerical, typographical, or proofreading errors, or
omissions.



Precautions

e When building a system, check the specifications for all devices and equipment that will
make up the system and make sure that the OMRON products are used well within their
rated specifications and performances. Safety measures, such as safety circuits, must be
implemented in order to minimize the risks in the event of a malfunction.

o Thoroughly read and understand the manuals for all devices and equipment that will make
up the system to ensure that the system is used safely. Review the entire contents of these
materials, including all safety precautions, precautions for safe use, and precautions for
correct use.

« Confirm all regulations, standards, and restrictions that the system must adhere to.

Software Licenses and Copyrights

This product incorporates certain third party software. The license and copyright information
associated with this software is available at http://www.fa.omron.co.jp/nj_info_e/.



Related Manuals

The followings are the manuals related to this manual. Use these manuals for reference.

Manual name Cat. No. Model Application Description
NX-series W578 NX1P2- oooo Learning the basic An introduction to the entire NX1P2
NX1P2 CPU Unit specifications of the system is provided along with the
Hardware User's NX1P2 CPU Units, following information on the CPU Unit.
Manual including introductory | * Features and system configuration
information, ¢ Introduction
designing, installation, | * Part names and functions
and maintenance. * General specifications
Mainly hardware ¢ Installation and wiring
information is * Maintenance and inspection
provided.
NX-series W579 NX1P2- oooo Learning about the Of the functions for an NX1P2 CPU
NX1P2 CPU Unit details of functions Unit, the following information is
Built-in 1/0 and only for an NX-series | provided.
Option Board NX1P2 CPU Unit and | ¢ Built-in 1/0
User's Manual an introduction of » Serial Communications Option Boards
functions for an * Analog I/0O Option Boards
NJ/NX-series CPU An introduction of following functions for
Unit. an NJ/NX-series CPU Unit is also
provided.
* Motion control functions
 EtherNet/IP communications functions
» EtherCAT communications functions
NJ/NX-series W501 NX701- oooo Learning how to The following information on a
CPU Unit NJ501- oooo program and set up Controller built with an NJ/NX-series
Software User’s NJ301- oooo an NJ/NX-series CPU | CPU Unit.
Manual NJ101- oooo Unit. * CPU Unit operation
NX1P2- oooo Mainly software * CPU Unit features
information is * Initial setting
provided. * Programming based on IEC 61131-3
language specifications
Use this manual together with the
NX-series NX1P2 CPU Unit Hardware
User's Manual (Cat. No. W578).
NJ/NX-series w502 NX701-oooo Learning detailed The instructions in the instruction set
Instructions NJ501-oooo specifications on the (IEC 61131-3 specifications) are
Reference Manual NJ301-oooo basic instructions of described. When programming, use this
NJ101-ooo0o an NJ/NX-series CPU | manual together with the NJ-series CPU
NX1P2-oooo Unit. Unit Hardware User's Manual (Cat. No.
W500) and NJ/NX-series CPU Unit
Software User's Manual (Cat. No.
W501).
NJ/NX-series w507 NX701-oooo Learning about The settings and operation of the CPU
CPU Unit NJ501-oooo motion control Unit and programming concepts for
Motion Control NJ301-oooo settings and motion control are described. Use this
User’s Manual NJ101-oooo programming manual together with the NJ-series CPU
NX1P2-oooo concepts. Unit Hardware User's Manual (Cat. No.

W500) and NJ/NX-series CPU Unit
Software User's Manual (Cat. No.
W501).




Manual name Cat. No. Model Application Description
NJ/NX-series w508 NX701-oooo Learning about the The motion control instructions are
Motion Control NJ501-oooo specifications of the described. When programming, use this
Instructions NJ301-oooo motion control manual together with the NJ-series CPU
Reference Manual NJ101-ooo00 instructions. Unit Hardware User's Manual (Cat. No.
NX1P2-oooo W500), NJ/NX-series CPU Unit
Software User's Manual (Cat. No.
W501),and NJ/NX-series CPU Unit
Motion Control User’s Manual (Cat. No.
W507).
NJ/NX-series W505 NX701-oooo Using the built-in Information on the built-in EtherCAT
CPU Unit NJ501-oooo EtherCAT port on an | port is provided. This manual provides
Built-in NJ301-oooo NJ/NX-series CPU an introduction and information on the
EtherCAT® Port NJ101-ooo00 Unit. configuration, features, and setup. Use
User’s Manual NX1P2-oooo this manual together with the NJ-series
CPU Unit Hardware User's Manual (Cat.
No. W500) and NJ/NX-series CPU Unit
Software User's Manual (Cat. No.
W501).
NJ/NX-series W506 NX701-oooo Using the built-in Information on the built-in EtherNet/IP
CPU Unit NJ501-oooo EtherNet/IP port on an | port is provided. Information on the
Built-in NJ301-oooo NJ/NX-series CPU basic setup, tag data links, and other
EtherNet/IP™ Port NJ101-ooo00 Unit. features is provided. Use this manual
User’s Manual NX1P2-oooo together with the NJ-series CPU Unit
Hardware User's Manual (Cat. No.
W500) and NJ/NX-series CPU Unit
Software User's Manual (Cat. No.
W501).
NJ/NX-series W503 NX701-oooo Learning about the Concepts on managing errors that may
Troubleshooting NJ501-oooo errors that may be be detected in an NJ/NX-series
Manual NJ301-oooo detected in an Controller and information on individual
NJ101-oooo NJ/NX-series errors are described. Use this manual
NX1P2-oooo Controller. together with the NJ-series CPU Unit
Hardware User's Manual (Cat. No.
W500) and NJ/NX-series CPU Unit
Software User's Manual (Cat. No.
W501).
Sysmac Studio W504 SYSMAC-SE2 ooo Learning about the The operating procedures of the
Version 1 operating procedures | Sysmac Studio is described.
Operation Manual and functions of the
Sysmac Studio.
NJ/NX-series W514 NX1P2-oooo Learning startup The operations from hardware
Startup Guide for NX701-oooo procedures and assembly through debugging for axis
Motion Control NJ501-oooo Sysmac Studio parameter settings, simple one-axis
NJ301-oooo operating procedures | positioning, and two-axis linear
NJ101-oooo for someone that will | interpolation are described.

SYSMAC-SE20oo
R88M-1o
R88D-1SNo-ECT

use NJ/NX series
motion control
functions for the first
time.
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1 Programming the NX1P
T

This section describes the fundamental elements of programming an NX1P

Machine Automation Controller.

1-1 OVEBIVIBW ...ttt ettt et e e e e e e e e st e e emte e e enneeenneens
1-2 Features of NX1P Programming ........cccevcuiereeiiiiie e eeeee e e
1-2-1 Challenges in Development and Solutions Using the NX1P
1-2-2 Easy to Add Programs.........cccccveveeeieeiiee,
1-2-3 Easy Motion Programming ...........ccoocieeeiiiieiiiinieee e
1-2-4 Structured Text Language for Easy Mathematical Processing
1-3 Programming with Variables..............ooiiii e,
1-3-1 Programming the NXAP ...,
1-3-2 Data TYPES ..eeeeiieiiiei e
1-3-3 Benefit of Using Data Types.......cccvveeveeeiiiciieeee e
1-3-4 International Standard IEC 61131-3.......ccocoiiiiiiiiiie e
1-4 Programming SOftWare ..........coooviiiii e
1-4-1 Programming Software Sysmac Studio............ccccevviiiiiiniieieinne
1-4-2 SIMUIGLIONS ...
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1-1 Overview

The photo below shows an NX1P2 CPU Unit. Push-In Plus terminal blocks are used to
connect a power supply and I/O devices.
EtherCAT and EtherNet/IP ports are built in.

Y] Push-In Plus

p“a!iel terminal
= block

Ethen'et/IP:

EtherCAT

Features
1. The built-in EtherCAT port and advanced motion control make machines faster and more
precise
« Up to four axes of motion control. Electronic cams and interpolation increase machine
speed and precision
« EtherCAT simplifies the wiring to up to eight servo systems including for single-axis
position control
2. Networks for loT
« EtherNet/IP enables communications with a host PC and data links between
NJ/NX-series Controllers and CJ-series PLCs
3. Push-In Plus terminal blocks
« Push-In Plus connection reduces wiring time when a control panel is built

The environment for programming the NX1P makes development faster and easier.

This Guide describes the features of NX1P programming and how to program the NX1P
using the Sysmac Studio.

15



1-2

1-2-1

16

Features of NX1P Programming

Challenges in Development and Solutions Using the NX1P

As manufacturers need to improve productivity and quality, machines are getting more
advanced and more complex. Engineers are facing challenges such as reducing
engineering costs, improving programming efficiency, and minimizing training costs.

@ Reduce engineering costs:
It is difficult to implement complex
positioning control and data
processing algorithms for advanced

machines in ladder diagrams only I
@&3&* ey

@ Improve programming efficiency: 3 L@%v 7 .w‘

Advanced machines increase

program size &‘aﬂ
l/ T lﬂ'

@ Minimize training costs:
Most engineers do not learn ladder
programming at school

Challengesin
production sites

The NX1P can offer solutions to each challenge.

A positioning program can be
1 created easily using motion FBs.
- ST language can be used for
mathematical and data processing.

Programming with variables

2 enables existing program to be used
as software components and
reused.

Programming using ST language
and variables allows engineers
3 ~ who learned high-level languages
~ such as BASIC and C to create
NX1P programs without training.

The next section gives more detailed explanation about programming the NX1P.



1-2-2 Easy to Add Programs
I Previously

When adding a program, the user needed to check whether the I/O addresses and memory
area used for the additional program had already been used. If they were used,
modifications and debugging were required. These tasks reduced development productivity.

Existing program Program to add (reused)

0 . ] - o T 155 e [ )
BOGO00 [3019 (3027 (5002 7028 1224 2015 (6303 (4038 |2040 3020

BO00Z0 Memory area used for
DOCO30

BG40 existing program

; ki < - —-- Memory area used for
DO0008s0
booroo. program to add

I Programming the NX1P

When a program is reused, the NX1P automatically allocates memory addresses in the
memory area for variables. The user does not need to worry about addresses when adding or
modifying the program. Debugging time can also be reduced.

Existing program Program to add (reused)

DataA[0]
DataA[l]

DataA[2] Memory area allocated for
Dabh! | variables of existing program
DataA[9] _

DataB[0]
DataB[1]

DataB[2] Memory area allocated for
bambie] variables of program to add
DataB[9]

17



1-2-3  Easy Motion Programming

I Previously

The traditional PLC (e.g., CJ2) used three different software applications for Position Control
Unit settings, ladder programming, and Servo System settings. The user had to create a
program while monitoring and tuning the settings.

CPU Unit Pasition Control Unit
. [

Pulse
4 output
v | Paramete T
*| Seftings F —

I Programming the NX1P

Operations such as turning ON the Servo, homing, and positioning can be described in one
program by using motion FBs.

Processes are executed from top to bottom, which makes the program easy to read.

The Sysmac Studio integrating ladder programming, motion, and Servo configuration
facilitates positioning control. Simple monitoring and modification!

Power]
MC_Power
Sarvolock MC_Axis000— Axis Axis-HC_Axis000
|—————&nabia Status,
Busy—
Error
SrorDi— Servo power ON
Movel
MC_MoveRelative
Start! Complesel MC_AxisOOO—Ats —— —— Axis—MC_2xis000
Executs Dong|
Distance 20 —|Distance Busy|—
Velocity 10 =—{Velocity Actival—
200 —Ac = Abcried —
Deceleration 200 — Dacaleration Emror— i
—eric emrp|-  Helative
—{Buffarioce positioning

Ladder + motion Servo System

18



1-2-4  Structured Text Language for Easy Mathematical Processing
I Structured Text Language

The structured text (ST) language is a high-level structured language, similar to Pascal. It is

ideal for mathematical processing and nested conditional branching that are difficult to write
in ladder diagrams.

I Features of ST Language

You can create easy to read programs by using two different programming languages,

ladder diagram language for sequence control and ST language for mathematical
processing.

Example: Calculating the area of a trapezoid
(Top length + bottom length) * height / 2

start F = !
— 1 ———&n END EM ENO EM ENO
a—{Inl —t1 t1—In1 —t2 t2—{Inl —5
b—{In2 h—In2 REAL#2.0-In2

The ST language simplifies this code.
start

T30 .
= 1 S=(a+b)h/20; m

You can use ST as an element in a ladder diagram or create a program in ST only.

ST is ideal for:
1. Arithmetic operations and function calculation
+, -, %, 1, SIN, COS, TAN, etc.
2. Loop and condition constructs
IF THEN, FOR NEXT, etc.
3. Text string processing
Joining, extracting, searching, and replacing text strings

The next section gives more detailed explanation about programming with variables.
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1-3 Programming with Variables

1-3-1 Programming the NX1P

Variables are names defined by the user. They are used for programming the NX1P
although addresses are used for the CJ2 and other traditional PLCs.

I Programming the NX1P
Programming with variables eliminates the need to remember addresses and makes

programming faster and easier.
Programming with variables means that you can create programs using the names on your

control panel or touchscreen as shown below.

N sw |
®¢ oe =

sSwi Sw2 Timer0
/1 OH

L1

I Programming Traditional PLCs
I/O numbers and timer numbers (0.00 and TO000 shown in the figure below) are used to

program traditional PLCs such as CJ2.
For most PLCs, comments can be added to the numbers in order to easily understand what

the numbers mean. Omron calls the comment “I/O comment”.

20



I Difference between Programming with Addresses and with Variables

This section shows the difference between two programming methods.

The CJ2 program (created with the CX-Programmer) and NX1P program (created with the
Sysmac Studio) are shown below.

CJ2 program example

UI.IJEI 0.01 TIDIJ[ID 1.00 |
|

NX1P program example

SW1 SW2  TimerD
L):I—i/i—m

Two programs shown above were written to perform the same operation.
To program the NX1P, each variable (e.g., SW1 and L1) must be assigned in the I/O Map to
the corresponding input/output terminal to which the physical device is connected.

SW2  Timer0

/1

1/0 Map
Variable Terminal number

—> | SW1 Input Bit 00
> L1 Output Bit 00

Variables used in the program are linked with actual I/O (input/output terminals of the NX1P
in this example). You can change |/O assignments by simply changing the terminal number

in the I/O Map. The benefit of programming with variables is that there is no need to change
the program itself.

21
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I Previously

When changing the Unit configuration, you had to change addresses in the ladder program
because the addresses assigned to the I/O channels were changed.

L 000 W10 W11 L 002 200
| { { ! L
L 001 W12 1013
|  f ¥
’ L 002 w4 Wnis
. 1T 1T 1T
Add'F‘g ‘ L 000 W10 Wil L 002 © 200
a Unit | ¥ ¥ i1 .
I 001 W12 L0139
| { I |
I ooz W14 Wo15 ‘
| { f ——
Change all related
addresses in the
Addresses are changed ladder program

I Programming the NX1P

Even when adding Units, you just assign variables to new 1/O ports in the I/0O Map without
changing the program.

I/O Map for NX1P

Just assign the device
variables to the 1/0
ports of the added
Unit




1-3-2

Data Types

For example, you define a variable called L1 (meaning the 1st lamp). It is clear that L1
contains ON/OFF data because L1 is a lamp.

However, if you define a variable called Data1, Data1 may contain a decimal number,
decimal point number, or text string.

The data type defines the type of data that is expressed by a variable.

A variable is a container for data with a name and data type.

Variable = (Name) + (Data type)

= f
” /
"~ Programming l' Defines the range and type (e.g., integer,
using the name V¥ | real number, and text string) of data
==
SW1 SW2  Timer0 -------—-__———————————
L,E—VH/: =

I Examples of Data Types

The table below lists the data types used for the NX1P. The BOOL data type is used for
ON/OFF data, the INT data type for decimal integers, and the STRING data type for text
strings.

Although both the INT and DINT data types represent decimal integers, they have different
ranges of values.

The WORD data type for bit strings, the DATE_AND_TIME data type for date and time, and

other data types can also be used.

Classification Used for Data type Range of values Notation
Boolean ON/OFF status | BOOL Oto1 “1or0
of inputs and TRUE or FALSE
outputs
Decimal Numeric Signed INT -32768 to +32767 +30000, -20000
number operation
(integer) DINT -2147483648 to +12345678, -20000000
+2147483647
Unsigned |UINT 0 to 65535 60000
UDINT |0 to 4294967295 20000000
Floating-point | Real number |REAL Single-precision 0.15625
number floating-point values
LREAL Double-precision 1.0000000000000002
floating-point values
Text string Text string STRING Text strings (UTF-8) | 'OMRON’
displayed on Approx. 2,000 bytes | ‘Failure rate’
HMI
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1-3-3

24

Benefit of Using Data Types

When special instructions are used for a traditional PLC such as CJ2, different instructions
must be used for different types of data.
With the NX1P, operands of special instructions are specified with variables. As the

variables contain data types, there is no need to use different instructions for different data

types.

Even when the data length is changed from 16 bits to 32 bits, all you have to do is change
the data type. You don’t need to change the program or allocate memory.

e CJ2 or traditional PLC

mMowv(021)

#1234

Do

1 movi(aes)

#12345676

Do

1 movF(469)

+1234

Do

e NX1P

Move 16-bit value :MOV
(Moved data: 1234)

Move 32-bit value :MOVL
(Moved data: 12345678)

Move floating-point value :MOVF
(Moved data: +123.4)

\
MOVE
EN ENO
-
Enter Variable—In Qutl—Enter Variable
/

Different special instructions for
~ different types or lengths of data.
MOV, MOVL, MOVF, etc.

MOVE instruction only.

Specify the appropriate data types for
move source /In and move destination
Out when the type or length of data is

changed.
Move 16-bit value = INT
Move 32-bit value = DINT

Move floating-point value = REAL

The concepts of “programming with variables” and “data types” based on the international
standard IEC 61131-3 are rapidly spreading.



1-3-4

International Standard IEC 61131-3

I IEC 61131-3

IEC 61131-3" is an international standard that is initially published in 1993.
o Manufacturer and hardware-independent
« Reusable software components

« Five programming languages for a variety of purposes and skill levels
*1. IEC (International Electrotechnical Commission)

Five programming languages according to IEC 61131-3

IL (Instruction List) LD (Ladder Diagram)

POP_STK:LD 0 =t )

ST OFLO ﬁ]:

LS OTR “._TDT O
LT PTR Lo

SEC

(Sequent Icil Function Chart

IF R1 THEN
OFLO:=0;EMPTY:=1

ELSE POP & NOT EMPTY
OFLO:=0;PTR;=PTR1=1

ST (Structured Text) FBD (Function Block Diagram)

o IL (Instruction List): A low-level text language similar to assembly
o LD (Ladder Diagram): A graphical language written in a form similar to electrical circuits
o ST (Structured Text): A high-level structured language similar to Pascal
« FBD (Function Block Diagram):
A graphical language to describe the function as a set of elementary blocks
e SFC (Sequential Function Chart):
A graphical language used to program processes that can be split into steps

The NX1P supports LD and ST.

’3 Adoption of the IEC 61131-3 standard
The adoption of the IEC 61131-3 standard is widespread from Europe and North

America to Asia.
The NX1P support programming languages based on IEC 61131-3. Engineers can be

trained easily thanks to familiar programming languages.

25



1-4 Programming Software

1-4-1 Programming Software Sysmac Studio
I The Sysmac Studio

The Sysmac Studio provides an integrated development environment to configure, program,
debug, and maintain NJ/NX-series Machine Automation Controllers.

Features

1. One software integrates configuration, programming and monitoring

2. Programming with variables. Supports the ladder and ST languages and FBs '
based on IEC 61131-3

3. PLCopen function blocks for easy programming of complex motion profiles, and
Cam Editor for quick implementation of cam motion profiles

4. Integrated simulation and debugging
Motion trajectories in 3D can be pre-tested, and simulation of programs can be

performed. This reduces set-up and tuning time.
*1. ST language (Structured Text language), FB (Function Block)

Motion control

Safety Simulation

26



1-4-2 Simulations

The Sysmac Studio provides a variety of simulations.
The Simulator in the Sysmac Studio allows you to test programs without connecting physical
devices.

1. Check the operations of a program
- Sysmac Swdc I T T T

Controller  Simulation Tools: Help

| o |
I 700} A Data[3imlin  OutpmtempL(750] I

Watch (Table)1
Name | Index | Modify | Comment |Datatypel AT IDisplay forr|
[0 | ] INT [Decim ¥
[01] 11 | (21|31 |41es1e173s1 @1 10]11]12]{ 131 14][15][6][17 ] 18T 19]
1232000100700 0 0 0 O O O

3. Check a motion program by viewing the changes of positions and velocities sampled
by data tracing

4. Check motion trajectories by performing 3D motion monitoring, without connecting
physical devices

27



2

This section describes the process of hardware mounting and wiring and the
installation of the Sysmac Studio.
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2-1

System Configuration and Devices

2-1-1

Overview

Connect a Power Supply, Pushbutton Switches, and Indicators to the NX1P and create a
ladder program in Section 3 Ladder Programming.

Automation Software
Sysmac Studio
Standard Edition
Version 1.17 or higher

Machine Automation
Controller
NX1P

Ethernet cable
(100Base-TX/10Base-T)

SYSMAC-SE200D
(DVD only)
SYSMAC-SE201L
(1 license)

NX1P2-oooo

e
Pushbutton Switch Indicator Power Supply
A22NL etc. M22N etc. S8VK-S06024 etc.

The physical devices such as NX1P, Pushbutton Switches, and Indicators will help you
understand programming concepts.
Even if there is no physical device, you can check operation using the Simulator in the

Sysmac Studio.

Section 4, 5, and 6 explain about simulations.
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2-1-2  Wiring
I Wiring Pushbutton Switches

Wire Pushbutton Switches to the NX1P as shown below.

»
=
N
7
=
w

SWA1

External @
power —i—
supply 4"
for NX1P

,N@ - | COMu01 =03 =05 =07 =09 =11 =13 =15 =17 =19 =21
- | =00 =02 =04 =06 =08 "]10 =12 =14 =]6 w]8 =20 =22 =24

The power supply terminals for input devices
do not have polarity

I Wiring Indicators

NC NC =00 =02 =04 =06 NC =08 =10 =12 =14
B co(ov) =01 =03 =05 =07C1(0V) m09 =11 =13 =15 NC

{00 07
0

The power supply terminals have polarity
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I Push-In Plus Terminal Blocks

A push-in terminal block allows you to connect wires (e.g. ferrule) by just pushing them in.
Reducing wiring work can greatly reduce the time required to build control panels.
Push-In Plus Terminal Blocks were independently developed by Omron for easier wire
insertion and firmer wire holding ability than standard push-in terminal blocks.

You can connect and remove a wire (solid or ferrule) to/from a Push-In Plus Terminal Block
by following the procedure below. (Refer to the manual for connection and removal of a
stranded wire)

m Connecting a wire

Just push the wire into the terminal block until stopping. When connecting a stranded wire,
use a ferrule, or insert the wire after loosening the clamp spring with a tool and then remove
the tool.

-

E = |
- SHE
L W 1S |

Held securely with
clamp spring

m Removing a wire
Press a flat-blade screwdriver diagonally into the release hole to loosen the clamp spring
and then remove the wire. Remove the flat-blade screwdriver.

Flat-blade | Remove the
screwdriver 1 screwdriver
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2-2 Installing the Sysmac Studio

2-21 Installing the Sysmac Studio

The Sysmac Studio is the support software to configure, program, debug, and simulate
NJ/NX-series Controllers.

Use the following procedure to install the Sysmac Studio on your computer.

1. Set the Sysmac Studio installation disk into the DVD-ROM drive.
The setup program is started automatically and the Select Setup Language Dialog Box is
displayed.

2. Select the language to use, and then click the OK Button.
The Sysmac Studio Setup Wizard is started.

3. Follow the wizard to install the Sysmac Studio.

4. Restart your computer after the Sysmac Studio has been successfully installed.

2-2-2 Requirements for Installation

The system requirements for the Sysmac Studio are given in the following table.

oS CPU RAM Display
Windows 7 Minimum IBM AT or compatible with 2GB XGA
32-bit or 64-bit edition Intel® Celeron® processor 540 1,024 x 768
Windows 8 (1.8 GHz) 16 million
32-bit or 64-bit edition colors
Windows 8.1
32-bit or 64-bit edition Recommended IBM AT or compatible with 4GB WXGA
Windows 10 Intel® Core™ i5 M520 min. 1,280 x 800
32-bit or 64-bit edition processor (2.4 GHz) or the 16 million

equivalent colors

LLI Precautions for Correct Use

When the CX-One version 4 or lower has been installed, uninstall it before installing
the Sysmac Studio.
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3 Ladder Programming

3-1

3-2

3-3

3-4

3-5

3-6

This section describes how to write ladder programs using the Sysmac Studio.

Programming with the Sysmac Studio ..........ccccoeiieveiiiie e, 3-35
3-1-1 Programming Procedure............coveiiiiiiiiiiiiieieee e 3-35
3-1-2 Creating @ ProjeCt.......cooccuiiiiiii et 3-35
Parts of the Sysmac Studio Window ..., 3-37
3-2-1 Screen for Configurations and Setup ..........cccccvveieiiiiiiniiiiieees 3-37
3-2-2 Screen for Programming...........oocceeeiiiieeiiiiec e 3-37
Assigning Variables to Terminals ..., 3-38
3-3-1 Variable Names for Terminal Numbers ...........cccccoiiieniiiiiennnne. 3-38
3-3-2 /O MaP Setting.....cooiiiiiiiiiieie e 3-39
3-3-3 Checking WING....ceeie et e e 3-41
[IE=To [o [ Toll o oo | r=T a2 1 411 oV [ 3-42
3-4-1 Inserting Circuit Parts ...........cooiiiiiiiiee e 3-42
3-4-2 Keyboard Mapping........ccooiiiiiii e 3-42
3-4-3 RUIES ... 3-43
Example of a Basic Ladder Program...........cccccevvviiieeeiiiiee e eseee e 3-44
3-5-1 Practice of Programming a Ladder Diagram ............ccccccovieeeenne. 3-44
3-5-2 Writing the Algorithm ... 3-45
3-5-3 Program CheCK........coocuuiiiiee et 3-47
3-5-4 Saving the Program ... 3-48
3-5-5 Checking Operation onthe NX1P ......cccccceiiiiiiiiiiiiie e, 3-49
3-5-6 Checking Operation on the Simulator..............ccccccveeeiiiiiiieeenen, 3-50
3-5-7 Example of a Program Error (Offline) ........cccccovvieiiiiiiini 3-52
3-5-8 Example of an Error Occurred During Operation ...........ccccceeeennes 3-52
Example of a Ladder Program Using a Timer Instruction ...............cc.ccccce... 3-53
3-6-1 Self-holding RUNQG ..o 3-53
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3-7

3-8

3-6-2 On-Delay Timer (TON) Instruction............cocceeiiiiiiiiiiiic e 3-54

3-6-3 Exercise: Energy Saving Escalator ...........ccccconieiiiiiiniien e, 3-58
3-6-4 Checking the Operation of the Program ............cccccceeeeiiiiiiinenennn, 3-59
3-6-5 Checking the Operation of the Program (Watch Tab Page).......... 3-60
Example of a Ladder Program Using Date and Time .........cccccevcvvveeeeicnnenn. 3-62
3-7-1 Programming the NX1P Using Date and Time.............c.c.cceeooee. 3-62
3-7-2 Exercise: Continuous Operating Time of Escalator....................... 3-62
Fundamentals of Programming to Reduce Development Time.................... 3-66
3-8-1 POUs (Program Organization UNits) ...........cccoovieeeiiiiini e, 3-66
3-8-2 Programs and Execution Priorities (Tasks) ......ccccccceeeeviveeieeeenennnns 3-66
3-8-3 Functions (FUNs) and Function Blocks (FBS)........c.ccccceeviieiinnne 3-68
3-8-4 7= o110 1= S 3-69
3-8-5 Types of Variables ...........cooccciiiiiiiiiiecee e 3-70



3-1  Programming with the Sysmac
Studio

3-1-1 Programming Procedure

This section describes how to create a simple ladder program using pushbutton switches and
lamps.

The overall programming procedure is given below.

Creating a project

Assigning variables to connected I/O devices in 1/0 Map

Programming

|!|<|4|

Connecting NX1P to debug program using physical devices

3-1-2  Creating a Project
1. Start the Sysmac Studio.

Sys_mac _Studio

2. Enter the project name.
Select NX1P2, 9024DT/1140DT for the device parameter and 1.13 (version indicated on the
NX1P) for the version parameter, and then click the Create Button.
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E Project Properties

Project name New Project

g OMRON

Comment

Type Standard Project

lTi'i Select Deyice

Category Controller
Device NX1P2

Version LEE:

The following window is displayed.

% Additional Information

You can change the model, version, and other properties after creating a project file.

"M Select Device

Category

Device

Version




3-2 Parts of the Sysmac Studio Window

3-21 Screen for Configurations and Setup

B P

0.00 7 10,00
14

Configurations
and Setup

3-2-2  Screen for Programming

Edit Pane
“Senrch>
Confitaations md Setup ——
[ Yo I .
o B
[oAT AT | g O
| DATE_AND_TIME A_j | O
| TBME ] =]
= ﬁ!:,r—‘:‘ TimerlUp
v 1 g1l Tmertey ) )
Simulation
Pane
StartTime
- B e |
Programming -
Warchl
- . - -
1. Select an item 2. Make settings or 3. Use as setup
to set up create programs assistant tools
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3-3 Assigning Variables to Terminals

3-3-1 Variable Names for Terminal Numbers

Although Pushbutton Switches and Indicators are physically connected to the input and output
terminals of the NX1P, they cannot be used for programming now.

In order to create a program using the connected devices (I/O), you need to assign variable
names for the numbers of terminals to which devices are connected.

Any name can be assigned. Names related to the device type or processing are recommended.
For example, you can use “SW1” for a Pushbutton Switch connected to the input terminal 00 of
the NX1P because “SW1” is its name on the nameplate in the control panel. This makes it easy
to identify the device.

Nameplate in
~ ———__control panel
i

¥

Input Output
Terminal No. BitO0O Bit0O1 Bit02 Bit0O0 Bit01 Bit 02
Variable name SW1 SW2 SW3 L1 L2 L3
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3-3-2

/0 Map Setting

Set variables for terminals.
I/0 map setting means that variables used for a program are assigned to terminals (called “I/O
ports” in the Sysmac Studio) of the NX1P to which devices (I/O) are connected.

1. Double-click /O Map under Configurations and Setup on the Multiview Explorer. The I/O
Map is displayed.

=z
g

@
E,
T
5

Port

& EtherCAT Network Configuration

¥ 3 ;
Input Bit 00
Input Bit 01
Input Bit 02
Input Bit 03
Input Bit 04
Input Bit 05
Input Bit 06
Input Bit 07
Input Bit 08
Input Bit 09
Input Bit 10
Input Bit 11
Input Bit 12
Input Bit 13
Qutput Bit 00
Output Bit 01
Output Bit 02
Qutput Bit 03
O pi

¥ & CPU/Expansion Racks

Description

| RAW | Data Type |

Variable

Variable Comment

| Variable Type |

As the NX1P is selected for the device, all input/output terminals (I/O ports: Input Bit 00 etc.)

of the NX1P are displayed in the I/O Map.

2. Double-click an /0 port to enter a variable name.

Set variable names for input/output terminals as shown below.

Variable names for input terminals

Variable names for output terminals
R\ | Variable

Terminal No. RW  Variable  paia type Terminal No. Data type
name name

Input bit 00 | R swi1™ BOOL Output bit 00 | R L1? BOOL

Input bit 01 | R SW2 BOOL Output bit 01 | R L2 BOOL

Input bit 02 | R SwW3 BOOL Output bit 02 | R L3 BOOL

*1. SW means a switch (Pushbutton Switch).

*2. L means a lamp (Indicator).

3. Enter “SW1” in the Variable Column of Input Bit 00.

Port

& EtherCAT Network Configuration
" ¥ CPU/Bxpansion Racks
_ ¥ ' Built-in /O Settings

Input Bit 01
Input Bit 02
oo Yl

Description

Input Bit 01
Input Bit 02

Variable Comment

Variable Type |
VP

[Global Varables
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4. In the same way, set SW2 and SW3 for Input Bit 01 and 02 and L1 to L3 for Output Bit 00 to

02.

[ | Description |RMW | DataType |  Variable | “Variable Comment
_& EtherCAT Network Configuration
__ v & CPU/Expansion Racks
¥ ' Built-in /O Settings
Input Bit 00 Input Bit 00

Variable Type T

Global Variables

Input Bit 01 Input Bit 01

Global Variables

Input Bit 02 Input Bit 02 SW3

Global Varizbles

Input Bit 03 Input Bit 03 I
pout Bit 04 Input Bit 04 |

Input Bit 12 Input Bit 12 l

Input Bit 13 Input Bit 13

Output Bit 00 Output Bit 00

(Global Vanables

Output Bit 01 Output Bit 01

(Global Variables

Output Bit 02 Output Bi

Global Variables

Output Bit 03 Output Bit A |

Output Bit 04 Output Bit 04 |

The variable names have been linked with the terminal numbers.




3-3-3 Checking Wiring

1. Connect the NX1P to the computer (Sysmac Studio) via an Ethernet cable.

Ethernet cable

SW1 SW2 Sw3 L1 L2 L3

2. Go online, and then transfer the 1/0 map settings to the NX1P.

‘ Transfer to Con;roller ‘

N Y
|

3. Change the operating mode to PROGRAM mode to prevent the program from being
executed while checking 1/0 wiring.

| Change to PROGRAM mode |

4. Press the Pushbutton Switches to check whether the values of the input bits change in the
1/0 Map.

5. Select the I/0 port. Right-click and select Set or Reset from the menu to check whether the
Indicator turns ON or OFF.
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3-4 Ladder Programming

3-4-1 Inserting Circuit Parts
I Inserting a Program Input or Output in an AND Structure

Shortcut key:  Select a connecting line and press the shortcut key
Example: N.O. Input - C Key, output - O Key

Toolbox: Drag a circuit part from the Toolbox
Right-click: Right-click a connecting line and select Insert Input or Insert Output from the
Menu.

I Inserting a Program Input in an OR Structure

Shortcut key:  Select an input and press the W Key. (The N.O. input is inserted in an OR
structure)
Drag and drop: Drag the connecting line and select a circuit part from the pop-up menu

I Inserting a Rung

Shortcut key:  Select the start of a rung and press the R Key.
Right-click: Right-click a rung and select Insert rung above or Insert rung below.

3-4-2 Keyboard Mapping

The following table lists the shortcut keys that you can use when creating ladder programs.

Operation Shortcut keys Reference (Shortcut key in CX-Programmer)
Entering an N.O. input C Same key * C or L in CX-Programmer
Entering an N.C. input / Same key
Entering an OR with an N.O. input w Same key * Different cursor position
Entering an OR with an N.C. input X Same key * Different cursor position
Entering an output (0] Same key
Entering a NOT output Q Same key
Calling a function block F Same key * F for both FUN and FB
Calling a function | Different key  * First letter of instruction
Inserting a rung below the cursor R Same key
Inserting a rung above the cursor Shift + R

* Select Keyboard Mapping Reference from the Help Menu to display the Keyboard Mapping Reference.

42



3-4-3 Rules

I You Can

With the NX1P, you can program a ladder diagram that cannot be programmed with the CJ2 or
other traditional PLC.

® You can insert an output without inserting an input. (Always ON Flag is not required)
Functions and function blocks can also be inserted without inserting an input.

5

mWIOVE

EM EMGC
a—In Oui—h

® You can connect outputs, functions, and function blocks in series.

L2 L1
i
s
Timl
in MOVE TON out
| EN END) n Q
A—{In_ Out|-8 Set—PT_ETTim

I You Cannot

e You cannot set a rung without any circuit parts.
| = < |
® You cannot set a rung with only one input.

|— <

e You cannot connect any item other than output after an output.

in2

‘ ‘ in L1 out
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3-5

Example of a Basic Ladder Program

3-5-1

Practice of Programming a Ladder Diagram

I [Exercise] Coin Operated Parking Space

44

Three cars can be parked in the parking space. Create a program to turn ON the FULL lamp
(L3 (red lamp)) if the parking lots are full and turn ON the AVAILABLE lamp (L1 (green lamp)) if
one or more parking lots are available.

SWH1, SW2, and SW3 are used as sensors to detect presence of cars.

Sensor 2
(SW2)

Turns ON when the
sensor detects a car (SW1)

eCompleted program

Data Type | Constant |

SW1 SW2 SW3

—

i SW1 L1

R b

SW2
1

SW3

(=




3-5-2  Writing the Algorithm

1. Click POUs under Programming in the Multiview Explorer.
Programs, Functions, and Function Blocks are displayed under POUs.

Configurations and Setup
Programming

‘r‘-.n- fu
» = Programs
L ¥ Functicns

L Function Blocks

2. Double-click Section0 under Programs - Program0.

| 2 Configuraticns and Setup
L Pregramming
¥ il POUs
¥ & Programs

L ¥ Function Blocks

The Ladder Editor is displayed.

3. Write a ladder program on the Ladder Editor.

5 Hew project - new Contraller_0 - Sysmac Stud o N o o S
Insert Project Conwoller Simulavon  Tools  Help.

[T | 1 |4 =

1 L ﬂ.: A 1R |a .,u,QQ

Miltiview Explorer BN Sectiond - ProgramO x | ¥ Toolbox

new_Controller 0 ¥ =

» Analog Conversion

> BCD Conversion
Bit String Processing
Communications
Comparison
Conversian
Counter
Data Movement
Data Type Conversion
FCS
Ladder Tools
Math
Motion Control

Build Other
RumeE i Program Control
(I Description Location

SD Memory Card

% Additional Information

When a new ladder program is created, Section0 will be marked with a red ! mark ( ).
This mark means that the program contains an error. It will disappear when the program
is written correctly.
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(1) Insert a program input in an AND structure
Insert an input and enter the variable name.
1. Press the C Key or right-click a connecting line and select Insert Input from the

Menu.
Enter “s”. Select SW1 from
the variable list and press the
Enter Key
0 |

= |Isic

Just press the Enter Key
if you do not enter any
comments

In the same way insert circuit parts as shown below.

2. To insert an output, press the O Key or right-click a connecting line and select Insert
Output from the Menu.

[l SW1 SW2 SW3
|

(2)Insert a rung below.
1. Select the start of a rung and press the R Key, or right-click a rung and select Insert
rung below.

Right-click

- | Insert Rung Below 0 SW
— =

1 Sw2 5SwW3
— —

Edit Rung Comment

Copy ]

Delete
2 Q
Select All

Go To

Online Edit

(3)Insert a program input in an OR structure
1. Insert an N.C. input and an output.
Insert an N.C. input by pressing the / Key and then insert an output.

0 SW1 SW2 Sw3 L3
|
i SWi1 L
/1 '




2. Inset an N.C. input in an OR structure. Select SW1 and press the X Key, or drag the
connecting line from the start point to the end point and select N.C. Input from the

menu.

|
SWi

| =1
—

e )

Drag the connecting line
from the start point
to the end point

0
" Function Block
"~ InlineST
Line

3. Insert another N.C. Input in the same way.

0 SW1 SW2 SW3 &}
H O~

i SW1 L1
e O
/s

The program is completed.

3-5-3 Program Check
1. Select Check All Programs from the Project Menu.

Warnings and errors
are displayed
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2. Modify the program if an error is found.
The results of the program check are displayed in the Build Tab Page.
Modify the program if an error is found.

| | Description

| &3 [1 | A parameter is not entered for the |

< Useful function >
Double-click the line of the error to
jump to the location of the error

3-5-4  Saving the Program

1. Save and export the project file before taking the next step.
Select Save from the File Menu.

File Edit View Insert Project
Close
Save Ctrl+S
Save As...
Save As New Number...
Import...
Export...
Offline Comparison
Page Settings...
Print... Cerl+P

Exit

2. Select Export from the File Menu. Enter a file name and export the file to the desktop.

File FEdit View Insert Project

Close

Save Ctrl+5
Save As...

Save As New Number...
Import...

Offline Comparisan

Page Settings...

Print... Ctrl+P
Exit

Additional Information Difference between Save and Export

Save Export
The project is saved in the default The project is Saved as a file.
folder. The user does not need to
know where the project is saved.
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To open the To open the saved [Fo== = —
. project,

saved project, RS double-click the  |MCRESG—

click Open | ;:p:npp‘l:ﬁ file icon or Click <

Project on the [Seisses Import on the £ Import..

Start page. by Start page.




3-5-5 Checking Operation on the NX1P

Connect the NX1P and the Sysmac Studio and download the project (all data including the

program) from the Sysmac Studio to the NX1P to check operation.
1. Connect the NX1P to the computer (Sysmac Studio) via an Ethernet cable.

Ethernet cable

A .L .l
3 L1 L2 L3
2. Go online.

Start the Sysmac Studio and go online with the NX1P.

SWL SWI SW3
—
| W1 L1
—l O
w2

—1/1

SW3

—1/1

3. Download the project.
Click the Transfer to Controller Button.

5 New Fruject_i - new_{ 0 - Sysmac St

niew_Controller_0

Ld Configurations and Setup
Al Programming
¥ @ POUs

Transfer to Controller
1

» ta

& »  Tasks
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3-5-6

50

4. Change the operating mode to RUN mode.
Check the Controller Status Pane. If the mode is PROGRAM mode, change the operating
mode to RUN mode.

Change to RUN mode

m —

ONLINE ® Simulator
ERR/ALM ® RUN mode

5. Check operation.
Turn ON and OFF the SW1, SW2, and SW3 to check whether the AVAILABLE lamp (L1)
and FULL lamp (L3) turn ON and OFF.

Checking Operation on the Simulator

You can check operation using the Simulator in the Sysmac Studio, without connecting the
NX1P (offline debugging).

1. Select Run from the Simulation Menu to start the Simulator.

| 2 m @ Run _ Fs
| Run in PROGRAM made Alt+F5
I Multiview Explorer
Step Execution F10
Step In Fil

Continuous Step Execution
Execute One Scan

Breakpoint Window Alt+Fg

& » Pa Tasks

Calibration

Run in Execution Time Estimation Mode

2. The Simulator is started and connected after displaying some messages.

B e srogect_i i CartaIEE Syt ST T T

File Edit View Insert Project Controller Simulation, Tools Help

Multiview Explorer

new_Controller




3. Double-click the input. You can change the value between True (ON) and False (OFF) to
debug the program, instead of pressing the physical switch.

AlL+F5

Cerl+Alt+Break
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3-5-7 Example of a Program Error (Offline)

Delete the variable name “SW1” of input SW1 offline. Select Check All Programs from the
Project Menu. Errors are displayed in the Build Tab Page.

I8 New Project_1 - new._ - 0 - Sysmac Stuc

1

Gl

¥ @ POUs

¥ = Programs

¥ [ Prograr

Displays a description
of the error

3-5-8  Example of an Error Occurred During Operation

Click the Troubleshooting Button (!) in the toolbar when an error occurs. The example below
shows a verification error that occurs when the NX1W-CIF01 Serial Communications Option

Board is not connected physically but is connected on the Sysmac Studio.
* Double-click Option Board Settings under Configurations and Setup - Controller Setup to configure the

Option Board settings.
[l New Project - new_ Conraler B Sysmac Sida T Y T T T T s 8| %
| File Edit view Insert Project Controller Simulation Tool- ''=lg.

|t aa s a|s 4

Multiview Explorer
S =
new_Controlier 0 v
Event Name
84 Configurations and Setup

Controller

Press the Display Switch Displays status of NX1P

Button to display the details

The Option Board configuration setup does not agree with the actual
configuration.
[Causa]
(1) The Option Board configuration setup does not agree with the actual
configuration. “ontroller Statu
2) An Option Board is not mounted correcty.
= S ONLINE @ 192.168.250.1
Artached iofdniation/1 ZRR/ALM PROGRAM mode
Attached information 2
Attached information 3
Attached information 4

> B3 Tasks

Display Switch

7 Resetal
B Filter Edl

e ——
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3-6 Example of a Ladder Program Using

a Timer Instruction

3-6-1 Self-holding Rung
Create a self-holding rung to turn ON L1 when SW1 is pressed and stay lit until SW2 is

pressed.
0 SW1 o L1
l—( I | i O—l
I_ﬁ_ Self-holding rung |

1. Create the program offline.

2. Delete the program created in 3-5 Example of a Basic Ladder Program.
Right-click the rung numbers to delete while holding down the Ctrl Key. Press the Delete
Key.

o SWi W2 SW3
| | | | | |
[ [ [

3 sw1
/]
SW2
1/l
swa
/1

Although the ladder program is deleted, the 1/O Map settings are not deleted and remain the
same as those configured in 3-3-2 I/O Map Setting.

3. Create the following rungs.

L =

4. Click the SW1 input, and then press the W Key to insert L7 in an OR structure.
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3-6-2

54

5. Click the connecting line to insert an N.C. Input. Press the / Key and enter “SW2”.

0 swl1

| "
E.d

5

6. The self-holding rung is created.

4] Swi SW2

::“i_l {/k

On-Delay Timer (TON) Instruction

Create a rung to turn ON L2 in five seconds after SW1 is pressed.

Rung to add
0 SW1 SW2
_] /1
o == S ML M & N A _M__5_N_ S N 8 N & N S _N_5_N_58 B _ &8 K _ '8 K
1 Timerl g
! Lt TON J
| } In Q |
| T#55—PT ET|—TimerPV
]
! ]
________________________________  d

(1)Refer to the help for details of the TON instruction

¢ Select Instruction Reference - Timer - TON from the Help Menu.
8 New Project - . b s
Lo wontents

Multiview Explorer System Defined Variable Reference

5 o Keyboard Mapping Reference
new_Controller 0 v Online Registration...

| & Configurations and Setup About Sysmac Studio

b4l Programming

g a o
!EF E l% !J'E‘::i‘
B #-T-F | D | 4l
- FLATILTLEN TON
ﬂm"_ﬁrw:ﬂ_!l-: TRLEE 9 AP TV
l\'.'ﬁ_i\d:lﬁ.‘
Tow FFal=347 o !:r"" § B rstance [ FT @ ETY
=
| ===
- %
" Baypim
M =y . .
- e Select an instruction and
9 kBT .
=l =
i press the F1 Key to display

the Instructions Reference

7




S Additional Information

Difference between the TON instruction for the NX1P and the TIM instruction for the
traditional PLC

NX1P ”
(IEC-compliant ladder instruction) ifsdibonsiE e g & 02)

Timerl ' 4 — 4
TON
n Q 0000
T#55—PT ETHTimerlPV #50

TON (On-Delay Timer) TIM (100-ms BCD Timer)

Instance name (Timer1) CELNEEETY  Timer number (0000)

PT (T#5s)

Timer1.ET (elapsed time) or
specify a variable for ET (Timer1PV)

Second operand (#50)

SEEEDNS  TIM 0000

Output variable (Q) Timer Completion Flag (T0000)

(111

The TON instruction changes timer output Q to TRUE when the set time PT elapses after
timer input /In changes to TRUE.

The timer is reset when In changes to FALSE. Elapsed time ET changes to 0 and Q
changes to FALSE.

(2)Input the set time
Specify a TIME data variable for the input parameter PT when inputting the set time.
For example, input “T#10.12s” to set to 10.12 seconds.

T#-9223372036854.775808ms
bits (T#-106751d_23h_47m_16s_ | T#3s56ms
854.775808ms) to TIME#6d_10m
T#+9223372036854.775807ms | TIME#16d_5h_3m_4s
(T#+106751d_23h_47m_16s_ | T#1243 5h

854.775807ms) 1 T#10.12s_~
T#61mb5s (Equivalent to T#1h1mb5s)
TIME#25h_3m

T#12d3h3s
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® Adding a rung using the On-Delay Timer instruction
1. Inserta rung below.
Right-click the existing rung and select Insert rung below, or select the start of a rung
and press the R Key.

g SW1 Sw2
A
g " Insert Rung Below ﬂ

]
’ Edit Rung Comment

2. A rung is inserted below.

0 SW1 SWa2 LT
L 1 L
f 141
LT |

2t | | |
§ -

3. Insert the N.O. input L7 as shown below.

0 WL SWZ L1
| | L
f | 11

ilﬁi

4. Search for the TON instruction in the Toolbox on the right of the window or select TON in
the Timer in the Toolbox.

[| '» Analog Conversion

» BCD Conversion
p Bit String Processing
» Communications

P Comparison

5. Add the TON instruction by dragging it from the Toolbox.
* You can also insert the TON instruction by right-clicking the desired location, selecting




6. The TON instruction is inserted.

Enter Voriobie

L
Enter Vorigh

7. Enter the instance name of the TON instruction.
Click Enter Function Block and enter “Timer1”.

Timerl

LT TOMN

=" | n Q
-PT ET —Fnter Vorighle

8. Set the parameters.
PT: T#5s
ET: Timer1PV

Timert

| 3 TOM

H —n o
iy |

9. Insert an output that changes to TRUE when Timer1 times out.

Enter “L2” for the variable name.
| Timerl
i TOMN

i m q

LI |
| T#5s—PT ET—TimeriPY
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3-6-3 Exercise: Energy Saving Escalator

This section explains the operation of the TON instruction.

This escalator does not move until someone approaches it. When a person passes in front of
the sensor (SW1), the motor (L1) starts. In order to save energy, the motor stops in five
seconds after the last person passes.

il

Motor

) |

5 seconds

o 1
T, SR

Timer
(Timer1)

Tips

(1) Modify the created program.

(2)Insert an N.C. Input for timer output in the rung to stop the motor. There are two N.C.
input methods
(D Specify timer output as a work bit (e.g., Timer1UP).
@ Use Timer1.Q that represents the output status of the timer instruction.

(3)Modify so as to reset the timer when a person passes.

Add an N.C. Input (Timer1UP) in the first rung to stop L7 (the motor of the escalator in this
example) when Timer1UP changes to TRUE. Add another N.C. Input (SWT) to reset the
present value of the TON instruction. The program is completed.

m Example (Output Timer1UP for when Timer1 times out)

] &

1 . Timeri
11 ‘ SW1 | TON TimeriUP
Fa
b5 in 13
| T#55—PT ET|[—TimerlfPV o |
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3-6-4

m Example (Using Timer1.Q)

0 swi  swz[TimertQ l 51
—|u:|—w[—lfl—,
—|

displayed.
The list shows that Timer1 has four data: In (input signal), PT

1 — TimerL SN SW2 [timerl.
u (5w TON | | :]—1/
_I ,/; = g:r E? T | L PT TIME
ikl 5 imer : Q BOOL

1

B o ET TIME

HA—r 3

Enter “Timer1” and “.” (dot). A list of possible candidates is Tess—{PT £ |-Timertev

(set time), Q (timer completion flag), and ET (elapsed time).

Checking the Operation of the Program

Check the operation of the program.

1. Connect the NX1P to the computer (Sysmac Studio) via an Ethernet cable.

2.Go online, and then transfer the program to the NX1P.

‘ Transfer to Cor}troller |

3. Change input SW1 (passing person) to TRUE. Output L7 (lamp 1) changes to TRUE and
variable Timer1PV (present value of Timer1) is incremented as time elapses.

4. Change input SW1 to FALSE, and check that variable Timer1PV is reset.

5. Change input SW2 (stop button of the escalator) to TRUE, and check that output L1
changes to FALSE and variable Timer1PV is reset.

6. Change input SW1 to TRUE. Check that output L 7 automatically changes to FALSE and
variable Timer1PV is reset in five seconds after nothing is done.

‘ Present value of Timer1
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e Checking the operation using the Simulator
1. Select Run from the Simulation Menu to start the Simulator.

2. Double-click the input. You can change the value between True (ON) and False (OFF) to
debug the programs, instead of pressing the physical switch.

- Sysmac Studi

Controller Simulation Tools  Help

3-6-5 Checking the Operation of the Program (Watch Tab Page)

You can also check the operation of the program in the Watch Tab Page.
Monitoring can be performed online on the NX1P or offline with the Simulator in the same way.

1. Select Watch Tab Page from the View Menu. The Watch Tab Page is displayed at the
bottom of the window.

E New Project_1 - new_Controller_o - Sysmac Studio’
File  Edit View Insert Project Controller Simulation Tools Help

Multiview Explorer Alb+1
Toolbox Alt+2
Output Tab Page Ale+3
Watch Tab Page Alt+4
Cross Reference Tab Page Alt+5
Build Tab Page Alt+s

Search and Replace Results Tab Page  Alt+7

Differential Monitor Alt+9 %_1

Variable Table Ctri+shift+v Q)

Variable Manager... ET|—Timer1PV (0.000ms)
Smart Project Search Ctri+Shift+F B

Recently Closed Windows Ctri+5hift+H

Clear Recently Closed Windows History

Zoom »

Reset Window Layout

2. Click the Watch Tab Page 1 Tab.

| Watch (Table)1

Index | Comment |Datatypel AT |Display forr!

-

= t A E Watch (Table)1

Dim. 1 _ Dim. 2 - Dim. 3
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3. Click the Variables Bar at the top of the window. The variable table appears. Select the
variable to monitor from the variables (external variables and internal variables) used in the
program and drag it to the Watch Tab Page.

Register Timer1 by dragging it to the Watch Tab Page.

online fiiue Ml | Modify | Comment |Datatype| AT IDisplay forr!

False TRUE FALS EdDL Boole! ¥
550.000m! | ] TIME String
False TRUE FALS BOOL Boole ¥
0.000ms | ] TIME String

Click the ¥ mark, and check that data (timer start flag (/n), timer set value (PT), timer
present value (ET), and timer completion flag (Q)) contained in Timer1 can be monitored.

4. Select the variable to monitor in the Ladder Editor and drag it to the Watch Tab Page.

Register SW1 by dragging it to the Watch Tab Page.

Online value | Modify | Comment |Datatypel AT IDisplay forr|
TON
TRUE 'FALS BOOL Boolel v
550.000ms ] TIME
False TRUE FALS BOOL

0.000ms

TIME
| TRUE FALS |||

5. Execute the program. You can monitor the values.

6. Go offline before taking the next step.
Save and export the project file.
¢ Select Save from the File Menu.
« Select Export from the File Menu to export the file to the desktop.
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3-7

Example of a Ladder Program Using
Date and Time

3-7-1

3-7-2

62

Programming the NX1P Using Date and Time

For example, best before date and time that is 30 hours from production is printed on boxed

lunch.

A program is required to

acquire date and time of production and il o
calculate the best before date and time by adding T flows "“E;s‘:"%\
30 hours to the acquired date and time i [

OMmRON
Store Boxed lunch

Best before  04.28.2017 4:00 am
Produced on 04.26.2017 10:00 am

Programming with variables uses DATE_AND_TIME data (year, month, day, hour, minute, and
second), TIME data, and instructions to perform calculations easily.

Exercise: Continuous Operating Time of Escalator

Create a program to measure time by using the program created in 3-6-3 Exercise: Energy

Saving Escalator.

[Exercise] Acquire current time and calculate elapsed time

Measure continuous operating time of the escalator (continuous ON time of L1). Create a
program to subtract time of day when L1 turns OFF from time of day when L1 turns ON.

Sensor
(SW1)

Motor
(L1)

EEE- B

Tips

Continuous operating time of escalator

A
N

(1) Use the GetTime function to acquire current time.
(2) Use the SUB_DT_DT function to subtract date and time.
(3) The SUB_DT_DT function returns TIME data.




Add code to the program created in 3-6-3 Exercise: Energy Saving Escalator.

1. Insert a rung below.
Right-click the rung 1 and select Insert rung below, or select the start of a rung and press
the R Key.

0 SW1 SWZ  TimerlUP L1
1 | 1
— | | |/t
1 Timerl
L1 Swi TON TimeriUp
— /i noQ
T#55—PT ET|=TimerlP¥

:2|

2. Set upward differentiation for L 1.
Press the C Key, or right-click a connecting line and select Insert Input from the Menu to
insert an input. Press the @ Key, or right-click the input and select Diff Up from the menu.

i

3. Insert the GetTime function to acquire date and time when L1 changes to TRUE.
Press the | Key and enter “GetTime” as the function name

=

2

2 GetTime |

51
T —{EN ENO ‘

Enter “StartTime” as the output variable name.

4. In the same way create another rung to execute the GetTime function when L7 changes to
FALSE.
To set downward differentiation, press the % Key, or right-click the input and select Diff
Down from the menu.

2 L GetTime
—{ 1 —{En EMO
—StariTime
3 LL
— | 5
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5. Insert the GetTime function and enter “EndTime” as the output variable name.
2

LT GetTime
—| 1 N O

—StartTime

GetTime

L
—{ | |—{En END

6. Insert the SUB_DT_DT (Subtract Date and Time) instruction to subtract StartTime from
EndTime.
2

Lt GetTime
—| 1 |—{En EMO

—StariTime

GetTime SUB_DT_DT]

L
—| | —{En ENO EN ENO

|—EndTime EndTime—Inl =

StartTime—In2

Enter “LapTime” as the output variable name.

7. Click the Variables Bar at the top of the window to check the variable table.

- Sectiond - Program0 X

Variables

Data Type | Initial Value | AT | Retain | Constant | Comment
| Timer. | o | ]
| TimerlPV TIME O )
| TemarltiD RO O O
| StartTime DATE_AND _TIME | (|
EndTime DATE_ AND_TIME O O
| LapTime TIME ] Ic]
SWL SW2 Timeriup = E
— /=
L1
1 Timerl
1 sw TON TimeriUp
—y m 9
T*Ssﬁ'ﬁmerlw
2 1 [GetTime
—1 1 —{EN ENO
—StariTime
: 1t [GetTime [5Ue DT o]
| | —{FN ENO EN ENO
—EndTime EndTime—Inl —LapTime
StartTime—In2

StartTime and EndTime are registered as DATE_AND_TIME (date and time) data and
LapTime as TIME (durations) data.
The data types are automatically set according to the used instructions.
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8. Execute the program.

Transfer the program to the NX1P or change the operating mode to RUN mode to use the
Simulator in the Sysmac Studio.

Data Type | Initial Value | AT

| Retain | Constan

Comment

9. Click the Watch Tab Page 1 Tab.

Select StartTime, EndTime, and LapTime in the variable table and drag them to the Watch
Tab Page. Change the value of input SW7 from False to True and check the value of

variable LapTime. The value of variable LapTime shows the time from when output L1
changes to TRUE to when output L7 changes to FALSE.

Data Type | Initial Value | AT | Retain | Constant | Comment

Watchl
Name |
2017-06-
Program{.EndTime 2017-06- 123, DATE_ANI

Online value | Modify

| Comment |Datatypel AT IDisplay forr!

6:44. DATE_ANI

10. Go offline before taking the next step. Save and export the project file.
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3-8 Fundamentals of Programming to

Reduce Development Time

3-8-1 POUs (Program Organization Units)
e POUs
Mltiview Explorer &1 A POU (program organization unit) is a unit that is defined in the IEC
new_Controllerd | v D 61131-3 and used to build the user program. There are three types of
o enigumtions seel Setup POUs: programs, functions (FUNs), and function blocks (FBs).
FUNSs and FBs that are reusable software components make
programming easier.
3-8-2 Programs and Execution Priorities (Tasks)

® Programs
Separate programs for different processes make programs easy to read and reuse.

2 N

Program 1 Program 2 Program 3 Program 4 Program 5
(Ladder) (Ladder) (Ladder) (ST) (Ladder)
|
. N Hi 2 FOR =3 T0 50 DO | I'_‘
S— | m — Value ‘= Vaua  n
1 | :@ toggle = NOT loggle; |7
i}
|_] :@: e END_FOR Ly [
T T =

\Parts supply * Assembly ‘ Measurement » proggéging

" Handling /

POU

Two different programming languages, ladder diagram and ST, can be used. You can

choose the appropriate language for each process and also program in ST within a ladder
diagram program (inline ST).

® Tasks

A task is an attribute that defines when a program is executed. You
can set a task period for each program.

To execute processes with high speeds, assign the program to the
primary periodic task that has the highest execution priority.

By assigning processes that do not require high-speed processing to
the task that has the lower execution priority, you can reduce the load
on the NX1P. One or more programs can be assigned to one task.

Multiview Explorer

nm_ti:;{rélle?_ﬂi
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Primarytask  Periodic task Periodic task Program execution

2ms 3 10 ms N 100 ms : priority and task period
Task{ == | Task2 = ‘ Task3 - ‘ can be specified
. o - (assigning to task)

m

Program 1 Program 2 Program 3 Program 4 Program 5
(Ladder) (Ladder) (Ladder) (8T (Ladder)
L it a H—0 FOR 10'=3T0 50 DO _|H'__O__
—- 1 - Value = Value + n, = o~
[ "] s i e . _)
H——0 Lo 0 /
J Lu,_' l—O 1 E 3
Parts supply Assembly Measurement Data processing Handling

o Default task setting and addition of a program
1. When a project is created in the Sysmac Studio, Program0 (ladder program) is registered
in advance and assigned to the primary periodic task by default.
Create a program in ProgramQ because there is no need to worry about task setting.

2. When adding a program, right-click Programs under Programming - POUs and select
Add - Ladder or ST from the menu.
Program1 is added. Program?2 will be added when you add another program. When
changing the name of the program, right-click Program* and select Rename from the
menu.

Multiview Explorer ~

new_Controller 0

| 4 Configurations and Setup

Ladder
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3-8-3

68

3. When assigning the added program to a task, double-click Task Settings under
Configurations and Setup and click the Task Settings Button and the Program
Assignment Settings Button.

B e et - v Contaer 6 yarac s S ™ T T —

2 Program?

+ i

¥ [ PeriodicTaskd

1 Programd_
I Programé.
+ i

Functions (FUNs) and Function Blocks (FBs)

Functions (FUNs) and function blocks (FBs) are instructions used in programs.

In traditional PLCs like the CJ2, they are called special instructions (e.g., MOV instruction =
FUN, TIM instruction = FB).

In addition to system-defined FUN/FBs, the uses can define their own FUN/FBs (user-defined
FUN/FBs).

e User-defined FUNs/FBs
You can define the existing programs that will be used in
other programs as FUNs or FBs.
You can program using the user-defined FUNs/FBs, which
makes programming easier and faster.

Program

( User-defined FUN/F&

HH———0 ( | HH——0
| [
T o ( | 1
\_ 7

A
(1]
=
(/1]
(1]
N P




o System-defined FUNs/FBs

The FUNs/FBs available for the NX1P are listed in the Toolbox on the right of the window.
Drag an instruction to use in the program.

e Difference between FUN and FB

» Dats Type Conversion
» S

B Ladder Tools

¥ Math

Description Figure that Example
represents
instruction
An instruction Bit string processing (AND, OR, XOR,
Function that performs a o NOT)
(FUN) single function. - _,f:: ENC_Ouu Math (ADD, SUB, MUL, DIV, SQRT, LN,
The values of 2 —jm2 LOG, EXP, SIN, COS, TAN)
internal variables Comparison (GT, GE, EQ, LT, LE, NE)
are not retained. etc.
The values of Set, reset (SR, RS)
Function internal variables { IONT) Trigger (R_TRIG, F_TRIG)
block are retained until it Counter (CTU, CTD, CTUD)
(FB) the conditions TMELOs=PT S= BT Timer (TP, TON, TOF)
are completed, The name
such as for (instance name) Motion control (MC_HOME, MC_MOVE)
timers. is required. etc.
3-8-4  Sections
e Sections

Multiview Explorer

new_(fontrdiEli_ v

gl Configurations and Setup
A\ Programming

¥ i@ PoOUs

¥ & Programs

L ¥ Function Blocks
> T Data
> B3 Tasks

You can divide a ladder diagram into smaller units and set a name
for each unit. This makes the program easy to understand and
manage. The section can be moved and deleted.

Programs are executed from top to bottom in the order that the
sections are displayed in the Multiview Explorer. To change the
order of execution, you must change the order of the sections.

SectionO0 is registered in Program0 by default.
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o Adding a section
1. Right-click Program0 under Programming - POUs - Programs in the Multiview
Explorer. Select Add - Section from the menu.

b4 Programming !

¥ i@ POUs
W i Pr

L Seils

L Functions Hs

L% Function Bl _COPY

¥ i@l POUs
¥ = Programs
¥ [ Program0

L ¥ Functions

L = Function Blocks

3-8-5 Types of Variables

e Global variables
Global variables are variables registered in the I/O Map and used for more than one
program. They can be accessed from any program.

e External variables and internal variables
External variables and internal variables are used only within one program.
When global variables (SW7 and L17) are used in programs, the global variables are
registered as external variables. Variables that are registered in programs (Timer1 and
Timer1PV) are registered as internal variables.

i > = '

_ 2 Program 1 :
o F O < m H
e 5 D X :
= = At H
@ = 3 (G T :
H [@) - & o3 Internal i

15 55 o A variables

] o R— S T '

o 10 S |— c 2 '
i — "

T ] 9 © ° < :
c . = H
& e 38 j
; a ;

| - & & <m Program 2 :

o ) 2 0 |l & s
2 e | — o EE E
2 B 5 T 3 Internal :
Q Q .
2 H £ o . :
o : = n_= variables :
«Q .

3 i

*e é ,o"
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o Checking global variable
Check the global variables registered in 3-7
Example of a Ladder Program Using Date and Time. Double-click Global Variables under
Programming - Data in the Multiview Explorer.

Multiview Explorer

| Retain stant | Network Publish |  Commel

new_Controller 0 E2

= 1 [l  |Do not publish

> | sw2 BOOL BuillnlOy | [ 00 Do not publish
b4 Programming ETE BOOL BuittnlOy/+-- [ [] |Donot publish
v @l POUs e BOOL BuiltinlOy/- O 0 [Ponot publish

L2 BOOL BuittnlQ:/+-- | []  |Po not publish

BuiltinlOy/--- | [0  |Po not publish

Check that the variables such as SW1 and L1 registered in the /O Map are automatically
registered as global variables.

% Additional Information
Global variables are displayed in purple.

o Checking the variable table
Click the Variables Bar at the top of the Edit Pane.

Multiview Explorer © Sect Program0 %
L Variables A
new: Contiolier. 0 | 0 SW1 SW2 TimerlUP i
1
L Cenfigurations and Setup _| i i
b4 Programming 11
| e =
= &2 1 Timerl
LT swi TON TimerlUP
— noQ
T*Ss—‘f:\—nrrerlw
2 L GetTime
{1 = eno
(—StartTime
3 o E—— = |

The local variable table is displayed. Click the Externals Tab.
Multiview Explorer -1 ‘SectionD - Program@ X |

- Variables
new_Controller 0 A
Namespace - Using

® Functions

Function Blocks

I'I;HT " SW1 SW2 TimerlUP L
asks
— /1
55
L Timerl
Ll SWIL TON TimerlUP
— i n Q
T#Ssﬁi—ﬂmerlw

When variables (global variables) registered in the /0 Map are used in this program, they
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are automatically registered as external variables.
Click the Internals Tab.

Multiview Explorer - 1

| new_Controller 0

| 3 Configurations and Setup

Data Type | Initial Value | AT | Retain | Constant | Comment
TON

TimerlPV TIME

TimerlUP BOOL

StartTime DATE_AND_TIME

EndTime DATE_AND_TIME

oooozn

LapTime TIME

SW1 SW2 TimerlUpP

/I
1

Timerl

1 oswi Ton TimeriUp
/——n @
H}-T\'meflw

T#Ss# FT

Variables registered in this program are automatically registered as internal variables.




4

Creating Programs to Handle
Data

This section describes how to create programs to handle data.

4-2

Variables Used for Data ProCessing........ceeevvivieiiiiieeeesieee e 4-74
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4-2-10 Referring Values of Array Variables............ccccoveveiiiiiiicciiiiieeee e, 4-83
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4-1 Variables Used for Data Processing
4-1-1  Arrays

The CJ2 and other traditional PLCs use Data Memory Area as a memory area for data
processing and storage.

The NX1P does not have Data Memory Area and uses variables as memory used for data

processing.
Traditional PLC (CJ2 etc.) NX1P
DMO0000 All_Data[0] | — an_pata
DMO0001 All Data[1] (Name of a group of data)

DMO0002 <::> All_Data[2] (2.? Ith)l{lpf%r decimal

int

DMO0003 All_Data[3] Iegen)
: / Array specification
' Expressed by adding a
- 2 subscript enclosed in []
All Dataln to the name of a group

DMXxxxX _Dataln] by e

e Arrays

All_Data[n] shown above is called an “array”.

The elements of an array are expressed by adding a [subscript] to the name of the variable
that represents the entire array.

An element expressed by “variable name [subscript]” (e.g., All_Data[3]) is used as a
variable in programs.

Only one data type can be set for an array variable.

One name can be used for multiple variables, making the program easy to understand and
read.
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4-2 Programming Exercise

4-2-1 Application Example

Create a program to store the first 10 values measured by the Displacement Sensor when the
Photoelectric Sensor (PH1) turns ON.

Displacement
Sensor

PH1
(Photoelectric
Sensor)

NX1P

/ |

An Analog Input Option Board is
used to input analog data into
the NX1P

All_Data[0]

All_Data[1]
Analog data input
to o?ﬁm Board All_Data[2]

All_Data[3]

All_Data[9]

The value measured by the Displacement Sensor is stored in variable data? as analog data
and then stored as an element of array variable All_Data.

4-2-2 Programming

This section describes the procedure to check operation using the Simulator in the Sysmac
Studio, without using physical devices.

Creating a project

{

Assigning variables to analog input (Displacement Sensor) and
input (Photoelectric Sensor) in I/O Map

{

Creating an array

\

Programming

{

Checking operation on Simulator
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4-2-3 Creating a Project
1. Start the Sysmac Studio.

Sysmac Studio

2. Enter the project name. Select NX1P2, 9024DT/1140DT for the device parameter and 1.13
(version indicated on the NX1P) for the version parameter, and then click the Create
Button.

=3 Project Properties

Project name MNew Project

Author OMRON

Comment

Type Standard Project

lEﬁ Select Device
Category Controller
Device NX1P2

Version 113
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4-2-4  Configuring Analog Option Board Settings

1. Double-click Option Board Settings under Configurations and Setup - Controller
Setup in the Multiview Explorer.

Multiview Explorer

new_Controfler 0

& Built-in Ethe
LI Built

Multiview Explorer
new_(.:;mtrolll;a'r_-ﬂ.

¥ Configuration

Option board 1 'Not mounted
Option board 2 | Not mounted
NXIW-CIFO1
NXIW-CIF11
NXIW-CIF12

¥ Option Board 1 Serial Co'\yiw DARZT
Senal communications mode | NXJ-W-MABH']. -~

unit No. [

Baud rate [SE00GES

Parity 'EvEn
Stop bit @ 1bit (o)

¥ Option Board 2 Senal Communications Settings

4-2-5 Assigning Variables to the Option Board and Input Terminal

1. Select Configurations and Setup - /0 Map.
NX1W-ADB21 is displayed at the bottom of the 1/O Map.

Multiview Explorer C
Port | Description | RW | Data Type | Variable
new_Cantroller 0 Output Bit 03 Output Bit 03 RW BOOL
. Output Bit 04 Output Bit 04 RW BOOL
Qutput Bit 05 Output Bit 05 RW BOOL
Output Bit 06 Output Bit 06 RW BOOL
Output Bit 07 Output Bit 07 RW BOOL
Output Bit 08 Output Bit 08 RW BOOL
Output Bit 09 Output Bit 09 RW BOOL
Output Bit 10 Output Bit 10 RW BOOL
Output Bit 11 Output Bit 11 RW BOOL
Output Bit 12 Output Bit 12 RW BOOL
Output Bit 13 Output Bit 13 RW BOOL
Qutput Bit 14 Output Eit 14 RW BOOL
Output Bit 15 Qutput Bit 15 RW BOOL
"~ OptionB  w * QOption Board Settings
" OptionB ¥ NXIW-ADBZ1
- Chl Analog Input Value Valueofanaloginputl R
Ch2 Analog Input Value Value of analog input2 R
© NXBusM  w  MXBus Master




2. Select Ch1 Analog Input Value and enter “data1” in the Variable Column.

Output Bit 12

Output Bit 13 Output Bit 13

Output Bit 14 Output Bit 14

Output Bit 15 Output Bit 15
OptionB  w ™ Option Board Settings

OptionB ¥  NXIW-ADB21
Ch2 Analog Input Value

NXBush X Buc I

INT data from 0O to 4000 is stored in variable data? according to the analog input value of
the Displacement Sensor (0 to 10 V).

3. Enter “PH1” in the Variable Column of Input Bit 00 to which the Photoelectric Sensor is
connected.

r f—m m ‘ 1*
Po

B Ta a1

00 Inp ) R BOOL PH1

Bit 1 D BOO
Bit 0 BOO
Bt 0 BOO

Variable PH1 is changed between True (ON) and False (OFF) by changing the ON/OFF
state of the Photoelectric Sensor.
The data type is Boolean.

4-2-6 Program Example

When PH1 changes to TRUE, the MOVE (data movement) instruction stores the value of
variable data1 in the nth element of array variable All_Data and the Inc (increment) instruction
adds1ton(n=n+1).

The first time PH1 changes to TRUE, Data? (analog input value) is stored in All_Data[0]. The
next time PH1 changes to TRUE, it is stored in All_Data[1], and then All_Data[2].

PH1 MOVE Inc
EN ENO EN ENO
datal—{In  Out}—All_Dataln] O [ BN Y p— R | HE
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4-2-7 Creating an Array

Create array variable All_Datan].

All_Data[0]
All_Data[1]
All_Data[2]
All_Data[3]
All_Data[n]

1. Double-click Program0 - Section0 and then click the Variables Bar at the top of the Edit
Pane to display the variable table.

o vt - vt CoAIEE e S T

File Edit View Insert Project Controller Simulation Tools Help

2. Click the Internals Tab to create internal variables.
Use an array specification for a data type.
Enter “All_Data” into the Name Column and then enter “Array” into the Data type Column.
The data type name candidate ARRAY['? ?] OF ? appears.

Variables
Mamespace - Using

| Data Type | Initial Value | | Retain | Constant |

__.E.m

Al -

3. Enter “0” for the left question mark and “9” for the right question mark in the [?..?] section.
Next, enter “INT” for the question mark in the OF ? section. Array variables All_Data[0] to
All_Data[9] with the INT data type are registered.

Like with Data Memory Area of a traditional PLC (e.g., CJ2), values of variables can be
retained when power is turned OFF. Selecting the Retain Check Box.

Vana

Namespace - Using

Initial Value | AT E io_| Constant |
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4. Right-click in the internal variable table and select Create New from the menu.

Register INT variable n that is the element number of All_Data[n].

Enter “0” into the Initial Value Column in the variable table.
= Option Baard gs | & VOMap S 5

4-2-8  Entering Programming Code

1. Insert input PH1 and set upward differentiation. Select a connecting line and press the C
Key. Right-click the input and select Diff Up from the menu or press the @ Key.

S Edit

Go To Variable Table

Insert Parallel Input Above
Insert Parallel Input Below

Add to Differential Monitor

Cut
Copy

Click Enter Variable and enter “PH1”.
0 PHL

it |

2. Add the MOVE instruction. Search for “MOVE?” in the Toolbox. Add the MOVE function by
dragging it from the Toolbox. (Or press the | Key and enter “MOVE”.)

Data Type
ARRAY[0.9] OF INT

MC_MaveAbsolute

MC_MoveCircular2D

80



3. Enter variables “data1” and “All_Data[n]” into the MOVE instruction.

o PH1 MOVE
11 EN ENO

daetal—In Ouir—Aall Dataln]

4. In the same way as the MOVE instruction, enter variable “n” into the Inc instruction.

2 PH1 MOVE Inc
11 EN ENO EN ENO
datal—In Out|—All_Data[n] n—{InCut InDutl—n

4-2-9 Checking the Operation of the Program

This section explains how to check the operation of the program on the Simulator.

1. Select Run from the Simulation Menu to start the Simulator.

[ File...Edit... view. . Insert. . Project... Controller. | Simulation’Tools... Help
Run [
Run in PROGRAM mode Alt+F5

Multiview Explorer

new. Controller 0
Step Execution Fl10

Step In Fi1

| Retain | Constant | [

Continuous Stap Exacution
Execute One Scan

Breakpoint Window Alt+F9

Calibration

Run in Execution Time Estimation Mode i

Start NS Integrated Simulation

2. Select Watch Tab Page from the View Menu to display the Watch Tab Page (Table).
Drag All_Data in the variable table to the Watch Tab Page.

{Inter a e | Initial Value | AT | Retain | Constant | Comment

Watch (Table)1

Name Index Modify | Comment |Datatype! AT IDisplay forr!
Program.

ronjlt21t31 4 slsl7 el (o1 r10] (]2 131 1411 5T 16] 171 18119
000O0DOOOODOO
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3. Double-click data? in the MOVE instruction to set the value.
Enter “123” and press the Enter Key.

4. Press the Enter Key on N.O. input PH1 to change the value between True (ON) and False
(OFF).
Change the value of PH7 to True (ON). “123” is stored in the value of All_Data[0] in the
Watch Tab Page.

Watch (Table)1
Name | Modify | Comment |Datatypel AT |Display forrl
21 [3][41[5] (6] [7] (8] [9][10][11][12][13][14][15][16][17][18][19]
0 0 0o

Check that n of the Inc instruction is incremented by 1 and now it is 1.

5. Enter any value in data? several times.

Watch (Table)1

Name Index | Modify | Com
Proaram 41l Data

[1] I

}00 100 70 0D 0JO O 0O O

The values are set to array variable All_Data in order as shown above.



4-2-10 Referring Values of Array Variables

1. Use the following procedure to refer values of the registered array variables.
The figure below shows an example of the program to assign the value of All_Data[3] (the

4th value) to INT variable temp1.

Watch (Table)1 -0 x
Name Index Modify

| Comment |Datatype!l AT IDisplay forrl
INT Decim v Horzontal v

2. Go offline before taking the next step. Save and export the project file.
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5

Motion FB Programming

84

This section describes how to write programs using motion FBs.

5-1 Motion FB Programming...........oooocuiiiieiiieie e ccciiieee e e seeeee e e
5-1-1 Motion FB Programming..........occeeeeiiieeeeiiieee e
5-1-2 Programming Procedure..........ccccceeviviieiiiiieeeeeeeeeeee e,
5-2 Adding a Servo Drive and Setting the Parameters ............cccccooiiiiiiiee.
5-2-1 Registering a Servo Drive..........c.ocoi i
5-2-2 Registering the AXIS ...
5-2-3 Setting the Axis Parameters ........cccccoovcviiieiiiee e
5-3 Creating @ Program .........ccoiiciieee e eciee e see e e e s ere e e s ee e s e eeeeenes
5-3-1 Overview of the Ladder Program............ccoooviieeiiieeeiiien e
5-3-2 Motion FBS 10 USE .......ooiiiiiiiiei e
5-3-3 Writing the Ladder Program.............cccco oo,
5-4 [ F= ] = T I =T | o o S
5-4-1 Checking the Operation with Data Traces...........ccccccvviieeiiiineennns
5-5 3D SIMUIAHON. ...
5-5-1 Starting 3D Simulation ............ceeeiee e



5-1

Motion FB Programming

5-1-1

5-1-2

Motion FB Programming

This section explains how to create a program using PLCopen®-defined function blocks for
motion control (hereafter called motion FBs).

The motion FBs listed below can be used for the NX1P. You can implement your desired
motion control by combining the motion FBs.

Single-axis positioning J MC_Home MC_Move/Relative/Absolute

| PLCopen |

MC_MoveZero MC_MoveFeed MC_Stop —

Continuous operation J MC_MoveJog MC_MoveVelocity i

MC_TorqueControl

. . MC_CombineAxes MC_GearOut
Synchronized operatlonJ

MC_Phasing MC_MoveLink MC_Gearln

MC_GearIlnPos MC_Camin MC_CamOut

Others J MC_Power MC_SetPosition
MC_TouchProbe MC_ZoneSwitch
MC_SetOverride MC_Write

Programming Procedure

Create a program to perform simple positioning by using motion FBs.
The Sysmac Studio allows you to debug programs and check motion in 3D on the Simulator,
without using physical devices such as NX1P and Servomotors.

Creating a project
4

Creating Unit/network configuration

Checking operation on Simulator

v
v

This Guide mainly explains how to use motion FBs. Although it is required to set up the
Servomotor and Absolute Encoder in real applications, this Guide does not explain it.
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5-2

5-2-1

86

Adding a Servo Drive and Setting
the Parameters

Registering a Servo Drive

1. After creating a project, double-click EtherCAT under Configurations and Setup in the
Multiview Explorer to display the EtherCAT Tab Page.

2. Add a Servo Drive as the EtherCAT slave.
Click the Servo Drives in the Toolbox. The list of Servo Drives is displayed.
Double-click the Servo Drive to use. (Select R88D-1So in this example.)

54

‘Node Addres\twork ccmgurac-n

Master
Device nams
Model name
Product name

Digital IC
= Analog IO

Reference Clock = Encoder Input

Total Cable Length

Fail-soft Operation Setting  Failsoftoperaion v
Wait Time for Slave Startup J
PDO communications tim-— X e
Revision Check Method Seftting <= Actual device v
‘Serial Number Check Met-- | No check 2
DC Synchronous Correction Disable slave monitorine v

Device name R88D-15I
Set a name for the master. El R

u RBBD-1SNO4H-ECT Rev:1

3. The Servo Drive is added under the master.

Node Address|Network coruﬁuratil:rn
= Master
Master

REBD-ISNOIH-ECT Rev:l 0




5-2-2  Registering the Axis

1. Register the axis to perform motion control. Right-click Axis Settings under
Configurations and Setups — Motion Control Setup and select Add - Single-axis
Position Control Axis from the menu.

ark coﬁgumtc.n
Master
Master

| Moation Contral Asxi

¥ Data Trace -

v T —

¥ i POUs

L %5 Axes Group Settings

RESD-1SNO1H-ECT Revil

5-2-3  Setting the Axis Parameters

Double-click MC_Axis000(0). The Axis Parameter Settings Tab Page is displayed. Set the

parameters used in this exercise.

1. Set the parameters in the Axis Parameter Settings Tab Page.

Axis number
Motion control

Aodis use

Select Servo axis.

Control function ‘Single-an 'j)bs'rﬁh'éu?itn'ﬂ only v
Feedback control No contral loop
Input device 1 <Not assigned>

Input device 2
Quitnit desice
Qutput device 2
Output device 3

p Detailed Settings

v

Channel
Channel
Channel
Channel
Channel
Channel

Select Node : 1
R88D-1SNO1H-ECT (E001).
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2. Click the Unit Conversion Settings Button and check that settings are the same as
those shown below (default settings).

@ um @ nm @ degree @ inch

Reference: Unit conversion formula
{Number BE pilses (pule] 1 nmand pulse count per motor rotation [UDINT]

* j istanc: it of /]
{2} Work travel distance per motor rotation [LREAL] el destanke Uikt

% Additional Information

Although the 1S-series AC Servo System has a built-in absolute encoder, default
incremental encoder settings are used in this exercise.

When using as an absolute encoder, select absolute encoder in the Position Count
Settings Tab Page.

Count mode ) Linear mode @ Rotary mode
Modulo maximum position setting value 36
Modulo minimum position setting value

Encoder type




5-3 Creating a Program

5-3-1 Overview of the Ladder Program

Create a program using single-axis motion FBs to move a ball screw forward and backward
as shown below.

5-3-2 Motion FBs to Use

Three motion FBs are used for this exercise.

Instruction Name FB/FUN Graphic expression
MC_Pawer Power Servo FB MC_Power_instance
MC_Power
- Axis — s AXIS -
= Enable Status
Busy jmm
Error jmm
ErmoriD jm
Instruction Name FB/FUN Graphic expression
MC_Home Home FB MC Home instance
MGC_Home
- AXiS _ — AN j—
= Exgcute Dong jm
BUSY
CommandAborted e
Error
ErronD
FB/
Instruction Name FUN Graphic expression
MC_MoveRelative | Relative FB MC MoveRelative instance
Positioning — —
MC_MoveRelative
= AXIS i AXIS p—
- Execute DONE
== Distance Busy
- Velocihy Active
= Acceleration CommandAboried mm
= Deceleration EITor m
= Jerk ErroriD
= BufferMode

% Additional Information
MC_Home is the Home instruction. Set the homing operation in the Homing Settings
Tab Page that is displayed by double-clicking Axis Settings - MC_Axis000. Zero
position preset (default) is used for this exercise.
Zero position preset: The present value becomes 0 when the MC_Home
instruction is executed
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Multiview Explorer : MC_Axs000 (OMC1) X

new_Controller 0 - a Homir

¥ Homing Method

‘Operation selection at positive limit input [EVER=E fUm/immediate stop] ©
Operation selection at negative limit input REverse Wum/immediste siop

 Vislocity/Acceleration/Deceleration

5-3-3  Writing the Ladder Program

1. Start the Sysmac Studio and create a project.
Double-click Section0 under Programming - POUs - Programs - Program0 in the
Multiview Explorer to open the Ladder Editor.

2. Insert N.O. Input start in the first rung.
Insert the MC_Power motion FB and enter “Power1” as the instance name.
(Search for “MC_Power” and drag the motion FB from the Toolbox.)
Enter “MC_Axis000” into the parameter for Axis.

Section - Program %

Bl EtherCAT [ MC 0. MC1]
MC_po
o Powerl
MC_Power =
MC_Axis000—{ Axis Axis = MC_Axis000

start
= - - ——{enabie Status
Blisy |—Enter Vo~
Error(— able Drag
EmoriD -5 able ‘

MC Axis000

~ Toolbox

3. Insert output power?_done (or any other name you prefer).

0 Powerl
MC_Power

MC_AxisDO0— Axis Axisf—MC_AxisD00
start Powerl done

|———Enable Statu:

Busy—Enter Variable

Errorf—ér

ErrorlD—E
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4. Press the R Key to insert a rung below the first rung.

Insert N.O. Input power1_done and then insert the MC_Home motion FB.
Enter “Home1” as the instance name.

Powerl

MC.H
WIC_Power | ’ ome
M Axs000—{Axis ——— Ais |~ MC_Axis000
start Fowert_done z s
|
T -
Busy|
Error
EroriDl-- b Dra g
1 Homel
WMC_Home
MC_Axis000— Axis — A MC_AXiS000
Fowert_done
—— b——————Execute Done|
Busy|—
CommandAborted |
Ervor{—
ErroriD)

5. Insert output home1_done (or any other name you prefer).

1 Homel

WIC_Home
MC_Axis000— Axis — Axis {—MC_AxisB00

Powerl_done Homel,_done

Execute D

Busy—En
CommandAborted (—Erife

Ervor|

ErrorDi—Eni

6. Press the R Key to insert a rung below the second rung.
Insert N.O. Input home1_done and then insert the MC_MoveRelative motion FB.

Enter “Move1” as the instance name.
135000 (O,MC1 ‘Section0 - Program0 X + ‘Toolbox

£

WIC_Home
— Asis|—MC_Axis000

MC_Axis000— Axis

Powerl_done + mel_done
———Becute Dx
Busy|
CommandAborted
Error
ErroriD|— Ente: bie
2 Movel Drag

MC_MoveRelatve
WIC_AxisD00— Axis  ——

Axisi=MC * 5000
Home,_ done

Execute oone) ——————

Distance susy|

Velocity Activef—=
feration G
Deceleration Erro
Jerk ErrorlD}—£nte:
{e—{BufferMode

MC MoveRelative

7. Set the parameters as follows. (You do not need to set other parameters in this exercise.)
e Distance: 1000 (pulses)
o Velocity : 1000 (pulses/s)
These settings move the ball screw the set distance in a second.

Z Wowel

MC_MoveReiative
ME. ANiS000=— Axi§  —

Axis p= T _Axis000

Homel done
i i Execute Done
1000— Distance Busyt—Enter Variobie
1000— Velocity Active|—Enfer Variobie

\
m
o)
g
8
&

Acceleration CommandAboarted (= Ernfer Variobis
Enter Variohle— Deceleration Error = Enter Varnicbis
te— Jeric EmorlD—Enter Variabis

Enter Varigbie— BufferMode

91




8. In the same way as step 6 and 7, insert another MC_MoveRelative motion FB to move
the ball screw backward at the same velocity. Enter “Move2” as the instance name. Set
the parameter for Distance to -1000 to move backward.

Mowel Move2
MC_MoveRetative MC_MoveRelative
MC_Axis000—{ Axis —— Axisp—=MC_Axis000 MC_AxisOI0— Axis —— Axisi—MC_Axis000
Execute Done Execute Done
1000 Distance Busy Distance Busy

Velocity Active Velocity Activel— Enfer Variokis

Acceleration CommandAborted

Acceleration CommandAborted

Deceleration Error

Deceferation Esrorp—Enter Variakie

Jeri ErmorlDy—Er

Jerk EmrorlD

BufferiMode BufferMode

9. Insert output move _done as shown below.

Maovel Move2

MC_MoveRelative MC_MeoveRelative
MC_AxIS000— AXiS —— Axis b= MC_Axis000 ME_AxisO00— AXIS  =—— A e WC_AxiS000
Homel don  Move_done Move done
—-l I— —|/}— ————Execute Don Execute Done
1000— Distance Busy| -1000— Distance Busy

1000— Velocity Active 1000— Velocity Active

Acceleration CommandAborted Acceleration CommandAboried

Deceleration Error| Deceleration Error|
Jerk EmoriD Jerk EmorlD
BufferMode BuiferMode
The program is completed.
m Completed program
o Powerk
MC_Power
ME_AxisO00— Axis ————— Asxis|—MC_Ax:000
start Powerl_dons
—| liinable Status
Busy
Error
ErrodD
1 Homel
MC_Home
MC_Axiz000— Axis — Az —MC_Axi=000
Powerl_dons Homel_done
Execute D
Buszy
CommandAboried
Error
2 Movel Moveld
MC_MoveRelative MC_MovaRelative
MC_AxisT00— Axis is [—MC_Axas000 MC_Axis000— Axis i) 0
Homsl done Move done Move_dons
f I/I Execute D Execute Done
1000~ Distance Busy Distance Busy
1000— Velocity Active Velocity Active
arisbl=— Acceleration CommandAboried Acceleration CommandAbartad
Deceleration Error Decsleration Error
e—{terk ErroslD Jerk Errodl:
& Bufferhlode BufferMode




5-4 Data Tracing

5-4-1 Checking the Operation with Data Traces

Use the traced data to check the positions during single-axis motion control.

1. Right-click Data Trace Settings under Configurations and Setup in the Multiview
Explorer and select Add — Data Trace from the menu.
DataTraceQ is added.

DataTraced

2. Double-click DataTrace0 to make settings. Select the Enable trigger condition Check
Box and enter “Program0” and “.” (dot). A list of possible candidates is displayed.
Select home1_done and TRUE (rising) to set the execution condition of the motion FB.

Aois Time (ms) v

Trace type Single® ¥ Sampling interval Every period of task ™ PrimaryTask ¥ Trace No. @

Number of samplings pREE

Post-trigger data ratio

| 1003 0 10000

M Start tracing at switching from PROGRAM mode to RUN mode M Refresh charts during tracing

@ SR Gl ERGLG N | Program0.Homel_done “TRUE {rising] v

3. Set the variable to trace.
Click the Add Target Button (+) and specify MC_Axis000.Cmd.Pos.
Enter “MC_Axis000” and “.“ (dot). A list of possible candidates is displayed. Select Cmd
(command value) and Pos (position).

Trace type [Single” ™ Sampling interval Every peniod of fask v Primarylask ™ Trace No. T

Number of samplings

Post-trigger data ratio [ Enableti diti s 0H 1d RS
- nable trigger condition risinall ¥
| 100 10000 #

B Start tracing at switching from PROGRAM mode to RUN mode B Refresh charts during tracing

Visible| Name X Offset] Y Offset]Y Axis Min.|Y Axis Max.| Cursor| Minimum | Maximum |Average|

N | N N Y s s

4. Select Run from the Simulation Menu. The program can be debugged without

connecting the NX1P physically.
Simulation starts and the color of the top of the Edit Pane changes to yellow green.

5. Click the Execute Button (red button) to start a trace.
A “Waiting for trigger ...” message appears on the status bar at the lower left of the
window.

» [ Data
= » Pa Tasks

Trace type Single ¥ Sampling interval

Number of samplings gRuey

Post-trigger data ratio

B o

Waiting for trigger .
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6. Double-click Section0 to open the Ladder Editor.
Use the Set and Reset menu commands to change program inputs and outputs in the
Ladder Editor to TRUE or FALSE.

Double-click start in the first rung and select True.

7. When start changes to TRUE, the trigger condition home1_done changes to TRUE and

the tracing starts.
2

The progress of tracing is displayed in a light blue progress bar at the lower right of the
window.
When the bar disappears, the tracing is completed.

| 'Simulation

8. Double-click DataTrace0 under Configurations and Setup - Data Trace Setting.
Check that position data is traced as shown below.
This graph shows that the Servomotor moves forward and backward every second. (The
X axis represents time and the Y axis represents travel distance (pulse).)

18000 2000

2000 10000 12
Time (ms)

items.




5-5 3D Simulation

5-5-1 Starting 3D Simulation

1. Click the Display 3D Motion Monitor Button shown below. Close unnecessary windows.

SENE =] bl

3D equipment model 'No 30 ‘equipment mode! is registered. | _ : 'EI

TimeOms

| Displayl Name

Conveyor for placing {with borders}
Motor rotation

Orthogonal robot (XY)

Orthogonal robot (XYZ)

g ool &

Workpiece (Conveyor system)
-Y Tables (Theta XY)
& 2 X-¥ Tables (XY Theta) = resolution unit
| X-¥-7 Stage + rotation axis [downward direction)
z | X-¥-Z Stage + rotation axis (upward direction) |

~ Present position

Orientation

a
e
Rzldeg] 0
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5. Enter “1000” into the 3D space size Box and “100” into the Scale resolution Box, and
then click the OK Button.

3D space size B Scale resolution unit [m|

6. Click the Trace Data Loading Button shown below to load the traced data.

Ei Load only the command values.

7. Check the 3D equipment motion by using the buttons shown below.

8. Use the three viewpoint operation buttons shown below to change and rotate your
viewpoint and zoom in and out of the 3D display area.

9. 3D simulation debugging is completed.

BT ENTEEEE N BEE B FH <ac sl v &

'S 'y

3D equipment model mf [ ] EEE

[ Load only the command values,

10. Go offline before taking the next step. Save and export the project file.



6 ST Programming
1

This section describes how to create ST programs.
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6-2 NX1P Programming in ST .....ooii e 6-100
6-2-1 Writing an ST Program for NX1P ..., 6-100
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6-3-1 Exercise of Numerical Calculation Programming............cccceeeueeee. 6-101
6-3-2 Programming ProCedures.........ccooeooieiiiiieieieee e 6-102
6-3-3 Checking the Program...........cooccuiiiiiieii i 6-104
6-3-4 Checking the Operation of the ST Program ...........ccccceiviiieennne. 6-104
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6-1

Overview of ST Programming

6-1-1

6-1-2

98

Advantages of ST Language

Machine control programs are becoming larger in size and more complicated. The
percentage of status control and interlock control that can be programmed easily in ladder
diagrams is decreasing. On the other hand, complex mathematical processing and data
storage that are difficult to program in ladder diagrams account for about 70% of an entire
program. The use of ST for this part makes programming easier and reduces program size.

Communications processing
Data exchange with host

Mathematical processing
Increased traceability

Connection with peripheral devices o ST Language

Increased visual inspection machines
HMI processing Ideal for these
Motion processes and

Flexible productionand productivi H
o et i ty reduces program size

Communicahions
processing

Mathematical processing

Connection With
peripheral devices

HMI processing

Ladder
programming Motion
was sufficient

N NN

- Ladder language

Previously Now In future

ST Programs Including Constructs

Branch and loop statements such as “IF” and “FOR” can be used in ST programming, like
BASIC and C programming.

Programs including mathematical processing and control statements, which are difficult to
write in ladder diagrams, can be created easily.

Begin the
IF NOT Fault THEN comment with //
Ready:=True; // Green light in ON state
AlarmSignal:=FALSE; Enclose the
(*Turn OFF the red 1li

comment in (* *)

ExecuteHoming:=TRUE; t time
CpenGrip:=TRUE;// rasping
END _IF;

IF ... THEN ...
END |F;
Control statements

Ready:=FALSE;
ExecuteHoming:=FALSE;

-

AlarmSignal:=TRUE;

(*Turn red light ONY¥)



6-1-3

Structure of ST and Example

Using general expressions, ST programming requires no special knowledge.

Remember the following two rules:

(1) Use a colon and an equals sign (;=) to assign a value to a variable.
(2) Statements must end with a semicolon (;).

I Example

6-1-4

An example of the statement to calculate the distance between two points using Pythagoras'

theorem is shown below.

Just apply the formula.

m Formula
Length = /(X1 — X0)Z + (Y1 — Y0)2
ength = /(X1 -X0)? + (Y1 - Y0) i B (X1, Y1)
(Y1-Y0)

A (X0, Y0) e (X1-X0)

m ST program

Length := SQRT((X1-X0)**2+(Y1-Y0)**2); > X

* SQRT: Square Root
Operators

Operator Operation Notation example Priority

() First priority Value := (1+2)*(3+4); // Value is 21 1

-, + Sign +100, -100 2

NOT Logical NOT Value := NOT TRUE; // Value is FALSE

** Exponent Value := 2**8; // Value is 256 3

* Multiplication Value := 8*100; // Value is 800

/ Division Value := 200/25; /[ Value is 8 4

MOD Remainder Value := 10 MOD 6; /l Value is 4

+ Addition Value := 200+25; /I Value is 225 5

- Subtraction Value := 200-25; /I Value is 175

<, > <=, >= Comparison Value := 60>10; /I Value is TRUE 6

= Matches Value := 8=7; /I Value is FALSE 7

<> Does not match Value := 8<>7; /l Value is TRUE

&, AND Logical AND Value := 2#1001 AND 2#1100; // Value is 2#1000 8

XOR Logical exclusive OR Value := 241001 XOR 2#1100; // Value is 2#0101 9

OR Logical OR Value := 2#1001 XOR 2#1100; // Value is 2#1101 10
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6-2 NX1P Programming in ST

6-2-1  Writing an ST Program for NX1P

You can create an ST program for the NX1P in two ways:
1. Using the ST language only
2. Partly using the ST language within a ladder program (inline ST)

In the second method, the ST program can be executed under a specified condition (e.g.,
when an input changes to TRUE) or can always be executed.

I 1. Using the ST language only ] | 2. Partly using the ST language within a ladder program
Program0 (LD) Program0 (LD)
Program1 (ST)
HAA0 = 100.0; _|
XRKA = 200,0;
|_— - O IF XXX0 > 150.0 THEN — - X0 = 100
L et it « Executed under a
IF XXX0 > 150.0 THEN ¢ s
7770 0.0 7220 300, SpeClﬁ&d condition
END_IF: END_IF:
XXX =300.0;
| | x%X0 = 100.0;
KKK = 200.0;
* All programs must be assigned to one o L ER «l Always executed
of the tasks. END_IF, ‘
(See Additional Information below,)

=

Adding a program and assigning the program to a task

Additional Information

(1) Right-click Programs and select Add - Ladder or Add - ST from the menu.

| & Configurations and Setup

(2) Double-click Task Settings under Configurations and
Setup in the Multiview Explorer and then click the Program
Assignment Settings Button. Select the program to assign
to Primary Task and set the initial status.

¥ I Py Tk

! Progeam0
[ Programt
+ o]
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6-3 ST Programming Exercise

Creating a project

Programming

Checking operation on Simulator

6-3-1 Exercise of Numerical Calculation Programming

Create a ladder program including inline ST to calculate the distance between two points.

I Exercise

Create a program to execute the ST code to calculate the distance between two points
when the Switch SW3 is pressed.

[Pythagoras' theorem]
A B (X1, Y1)

Length = /(X1 —X0)2 + (Y1 — Y0)?2

(Y1-Y0)

A (X0, Y0) N (X1-X0)
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6-3-2 Programming Procedures

1. Create a project. Double-click Section0 under Programming - POUs - Programs -
Program0 in the Multiview Explorer to open the Ladder Editor.

2. Click the Variables Bar to display the variable table.

File Edit View Insert Project Controller Simulation Tools Help.

| Initial Value | AT | Retain | Constant | Comment

Press the Insert Key to insert a row.
LREAL (double-precision floating-point) data enables precise decimal point calculation.

4. Insert a rung and N.O. Input SW3. Set upward differentiation. (Press the @ Key on the

N.O. input.)
SW3.
T

0
5. Right-click the connecting line as shown below and select Insert Inline ST from the
menu.

0 SW3
Th Insert Input {C)

Insert Cutput

Insert Funchtion Block

Insert Function
Insert Jump

| InsertInline ST

102



6. An inline ST box is inserted. Write the following ST code in this box:

Length := SQRT((X1-X0)**2.0+(Y1-Y0)**2.0);
0 SW3

—t 4

7. Enter “Leng” of variable Length. A list of possible candidates is displayed. Select Length
and press the Enter Key.
i

—]1 1[ Leng|

|
o7 Length
|@|§|@!]|E‘|E| | (Varioblz) LREAL Length |
T

“.

8. Enter a space and “” (colon). The assignment keyword := is entered automatically.
Length '.=|

9. Enter “SQRT” (Square Root) and “(* (left parenthesis). A description of the parameters is
displayed.

SW3 g
— 1 1) Length:=50QRT(

(Function) =4 [ANY_REAL] SQRT ([ANY_REAL] In)
In: Mumberto process
Square Root

|l
10.Enter “x”. A list of possible candidates is displayed. Select X7 and press the Enter Key.

SW3 — -
1 1 Length:zSQRT[}Er
o X0 | {Variable) LREAL X0
o X1
= XOR

HEEFES =

Enter the statement to the end.
' Length := SQRT( (X1 - X0 ) ** 2.0 + (Y1 - YO) ** 2.0 }|

Enter ;” (semicolon).

: Length ;= SQRT( (X1 - X0 ) ** 2.0 + (Y1 -Y0) ** 2.0 }:|
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6-3-3 Checking the Program

Inline ST programming is completed.

0 e —
_| 1 |_ 1 Length := SQRT ({ X1 - X0 )**2.0 + (Y1 - Y0 )**2.0} =

i
|
Select Check All Programs from the Project Menu to confirm that there is no error.
(Ignore a warning.)

Check All Programs F7

Check Selected Programs Shift+F7

| h
|

Build Controller Fg
Rebuild Controller

& Memory Usage
Online Edit

Library

6-3-4 Checking the Operation of the ST Program

1. Start the Simulator to check the operation.
Select Run from the Simulation Menu.

Il e ot - GO S ™ ™

File Edit View Insert Project Controller Simulaton Tools Help

[y s e -calas« B £g
L Run in PROGRAM mode Alt+F5
Multiview Explorer
new_Contraller 0 v .
Step Execution F10
| 3 Configurstions and Setup e g Stepin F11
v EEC : e
va . <
Continuous Step Execution O O
Execute One Scan = [
O O
Braakpaint Window Alt+F9 Ll L
L&, Function Blocks : ([ ]
1 Dst: — =
: =] T:r: - [ =
e Calibration
Run in Execution Time Estimation Mode II
ith 1y |
Start NS Integrated Simulation S
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2. Check the operation.
Synchronize (download) the program. Assign any value to variables of two points (X0, YO,
X1, Y1), and then press SW3. Check that the calculation result is displayed in the Online
value Column of Length.

il

Lengthp 5 |:=5QRT ((X1|p 6 -X0p 2 1720+ (Y1]p 4

Watchl

Name | Online value Modify | Comment |Data type!l AT |Display forrl
2 = ot | (ReaL Resl
1 Real
6 LREAL Real
Program0.¥1 4 LREAL Real
Pﬂ_:lgram.ﬂ..Lef_mm J 5 i I.REAL Real
Y

B X1=6, Y1=4)

X0 =2,

3. Go offline. Save and export the project file.

@ Additional Information

Write the code created in 4 Creating Programs to Handle Data in ST.
Instead of using the MOVE and Inc instructions, you can use ST language that is a
BASIC or C-like language.

e Ladder programming

Q0

= PH1 MOVE inc
1} EN ENO EN
datal—In Outj—All_Dataln] n—{InCut InQOut—n
== AT

e ST programming (inline ST)

1 PH1

1 1 All_Data[n] := datal; —i
2l mi=n+l; \
3l Assigns the right side to the left side

| (= MOVE instruction)
Il

Assigns the result of the expression n+1 to n

I_ (= Inc instruction)
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